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ค าน า 
 
 

   ส ำหรับชุดคู่มือสอบส ำหรับต ำแหน่งพนกังำนวเิครำะหน์โยบำยและแผน ท่ีท ำกำรปกครองจงัหวดั
นครศรีธรรมรำช เล่มน้ี ทำงสถำบนั THE BEST CENTER และฝ่ำยวิชำกำรของสถำบนัไดเ้รียบเรียงข้ึน  
เพ่ือใหผู้ส้มคัรสอบใชส้ ำหรับเตรียมสอบในกำรสอบแข่งขนัฯในคร้ังน้ี 
 
                        ทำงสถำบนั THE BEST CENTER ไดเ้ลง็เห็นควำมส ำคญัจึงไดจ้ดัท ำหนงัสือ เล่มน้ีข้ึนมำ  
ภำยในเล่มประกอบดว้ยทุกส่วนท่ีก ำหนดในกำรสอบ เจำะขอ้สอบทุกส่วน พร้อมค ำเฉลยอธิบำย มำจดัท ำเป็น
หนงัสือชุดน้ีข้ึน เพ่ือใหผู้ส้อบไดเ้ตรียมตวัอ่ำนล่วงหนำ้ มีควำมพร้อมในกำรท ำขอ้สอบ 
 
                         ทำ้ยน้ี คณะผูจ้ดัท ำขอขอบคุณทำงสถำบนั THE BEST CENTER ท่ีไดใ้หก้ำรสนบัสนุนและ 
มีส่วนร่วมในกำรจดัท ำตน้ฉบบั ท ำใหห้นงัสือเล่มน้ีสำมำรถส ำเร็จข้ึนมำเป็นเล่มได ้ พร้อมกนัน้ีคณะผูจ้ดัท ำ 
ขอนอ้มรับขอ้บกพร่องใดๆ อนัเกิดข้ึนและยนิดีรับฟังควำมคิดเห็นจำกทกุๆท่ำน เพ่ือท่ีจะน ำมำปรับปรุงแกไ้ข
ใหดี้ยิง่ข้ึน 
 

 
 
 
 

  ขอใหโ้ชคดีในกำรสอบทุกท่ำน 
ฝ่ำยวชิำกำร 

สถำบนั The  Best  Center 
www.thebestcenter.com 
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------------------------------------------------------------ 

 ความรู้เกีย่วกบักรมการปกครอง 
ประวัติกรมการปกครอง 
 กระทรวงมหาดไทยเป็นกระทรวงหน่ึงท่ีจดัตั้งข้ึนเม่ือวนัท่ี 1 เมษายน พ.ศ.2435 มีสมเด็จพระเจา้บรมวงศเ์ธอ
กรมพระยาด ารงราชานุภาพทรงเป็นเสนาบดีรับผิดชอบงานมหาดไทยหรืองานการปกครองประเทศและไดมี้การ
แบ่งหนา้ท่ีระหวา่งกระทรวงมหาดไทยและกระทรวงกลาโหมใหช้ดัเจนไม่ซ ้าซอ้นกนัโดยใหก้ระทรวงมหาดไทย
รับผิดชอบรวมการบงัคบับญัชาหวัเมืองทั้งหมดเพียงกระทรวงเดียว 
          กระทรวงมหาดไทยเม่ือแรกตั้งแบ่งออกเป็น 3 กรม มีช่ือเรียกตามท าเนียบเดิมแต่ใหมี้หนา้ท่ีต่างกนั คือ 
- กรมมหาดไทยกลางเป็นพนกังานท าการทุกอยา่ง ซ่ึงมิใหแ้ยกออกไปเป็นหนา้ท่ีกรมอ่ืน 
- กรมมหาดไทยฝ่ายเหนือใหเ้ป็นเจา้หนา้ท่ีแผนกการปราบปรามโจรผูร้้ายกบัแผนกอยัการรวมทั้งการเก่ียวขอ้ง
 กบัชาวต่างประเทศ (แต่ภายหลงัโอนการท่ีเก่ียวกบัต่างประเทศไปเป็นหนา้ท่ีปลดัทูลฉลอง) 
- กรมมหาดไทยฝ่ายพล าภงัใหเ้ป็นเจา้หนา้ท่ีแผนกปกครองทอ้งท่ี 
          ส าหรับการปกครองในส่วนภูมิภาคได ้ก าหนดรูปแบบการปกครองท่ีเรียกวา่ "เทศาภิบาล" ข้ึนมาใชแ้ละได้
มอบหมายใหก้ระทรวงมหาดไทยเป็นผูรั้บผิดชอบดูแลโดยจดัแบ่งหวัเมืองออกเป็นมณฑล เมืองและอ าเภอโดยมี
สมุหเทศาภิบาล ผูว้า่ราชการเมืองและนายอ าเภอเป็นผูป้กครองบงัคบับญัชาขา้ราชการและดูแลทุกขสุ์ขของ
ประชาชนในเขตทอ้งท่ีนั้น ๆ และมีก านนัผูใ้หญ่บา้นเป็นผูช่้วยเหลือปฏิบติังานในระดบัต าบลและหมู่บา้น  กรม
มหาดไทยฝ่ายพล าภงัจึงเป็นตน้ก าเนิดของกรมการปกครองซ่ึงไดมี้การเปล่ียนช่ือและปรับปรุงการแบ่งส่วนราชการ
ภายในมาเป็นล าดบั ดงัน้ี 
- พ.ศ. 2458กรมพล าภงั มีส่วนราชการยอ่ย คือกรมปกครองและกรมฝ่ายเหนือ 
- พ.ศ. 2459 กรมพล าภงัมีส่วนราชการยอ่ย คือกรมปกครองทอ้งท่ีและกรมการเมือง 
- พ.ศ. 2460กรมปกครองมีส่วนราชการ2แผนกคือแผนกปกครองทอ้งท่ีและแผนกการเมือง 
- พ.ศ. 2466กรมพล าภงั มีส่วนราชการยอ่ย คือกรมปกครอง และกรมการเมือง 
- พ.ศ. 2467กรมพล าภงั มีส่วนราชการยอ่ย คือ การภายในกรมภายนอก และกรมทะเบียน 
- พ.ศ. 2469กรมพล าภงั มีส่วนราชการยอ่ย คือ กรมปกครอง กรมทะเบียนและกรมราชทณัฑ ์
          หลงัการเปล่ียนแปลงการปกครอง พ.ศ. 2475 จากระบอบสมบูรณาญาสิทธิราชยม์าเป็นระบอบ 
ประชาธิปไตยแลว้ในปี พ.ศ. 2476   กรมพล าภงัไดเ้ปล่ียนช่ือเป็นกรมมหาดไทยต่อมาในปี พ.ศ. 2505 จึงเปล่ียนมา
ใชช่ื้อ "กรมการปกครอง" จนถึงปัจจุบนั 
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------------------------------------------------------------ 

 ความรู้เกีย่วกบัสภาพแวดล้อม สถานการณ์ปัจจุบัน การเมือง เศรษฐกจิ สังคม 

และเทคโนโลยขีองประเทศไทยและต่างประเทศ 

 "ข้าราชการ-ลูกจ้างประจ า" ประสงค์ขอรับเงินเดือน 2 รอบ เตรียมย่ืน 1-15 ธ.ค.นี ้
 "กรมบญัชีกลาง" แจง้ "ขา้ราชการ-ลูกจา้งประจ า" ท่ีประสงคข์อรับเงินเดือน 2 รอบ เตรียมยืน่ 
ความประสงคว์นัท่ี 1-15 ธ.ค. 2567 นางสาวทิวาพร ผาสุข รองอธิบดีกรมบญัชีกลาง ในฐานะโฆษกกรมบญัชีกลาง 
เผยวา่ ตามท่ีกระทรวงการคลงัไดก้ าหนดหลกัเกณฑก์ารเบิกจ่ายเงินเดือนขา้ราชการผา่นระบบจ่ายตรงเงินเดือนและ
ค่าจา้งประจ า (e-Payroll) ของกรมบญัชีกลาง พ.ศ. 2567 และหลกัเกณฑก์ารเบิกจ่ายคา่จา้งลูกจา้งประจ าผา่น 
ระบบจ่ายตรงเงินเดือนและค่าจา้งประจ า (e-Payroll) ของกรมบญัชีกลาง พ.ศ. 2567 
 โดยก าหนดใหก้ารเบิกจ่ายเงินเดือนขา้ราชการและค่าจา้งลูกจา้งประจ า มีการจ่าย 2 แบบ คือ  
การจ่ายเดือนละ 1 รอบ จะจ่ายตรงเขา้บญัชีเงินฝากธนาคารของขา้ราชการหรือลูกจา้งประจ า ในวนัท าการก่อน 
วนัท าการสุดทา้ยของเดือน 3 วนัท าการ และการจ่ายเดือนละ 2 รอบ จะจ่ายตรงเขา้บญัชีเงินฝากธนาคารของ
ขา้ราชการหรือลูกจา้งประจ า รอบ 1 ในวนัท่ี 16 ของทุกเดือน หากวนัดงักล่าวตรงกบัวนัหยดุราชการจะเล่ือนเป็น
วนัท าการก่อนวนัท่ี 16 ส่วนจ่ายรอบ 2 ในวนัท าการก่อนวนัท าการสุดทา้ยของเดือน 3 วนัท าการ โดยการจ่ายเงิน
ดงักล่าวเป็นการเลือกรับตามความสมคัรใจของขา้ราชการและลูกจา้งประจ า โดยสามารถยืน่แบบแสดง 
ความประสงคเ์พ่ือเลือกการรับ หรือขอเปล่ียนแปลงการเลือกรับตามระยะเวลาท่ีกรมบญัชีกลางก าหนด 
 ทั้งน้ี ขา้ราชการและลูกจา้งประจ า สามารถยืน่เอกสารแสดงความประสงคข์อเปล่ียนแปลงการรับเงินเดือน
ของขา้ราชการและการรับค่าจา้งของลูกจา้งประจ า ไดปี้ละ 1 คร้ัง โดยยื่นแบบแสดงความประสงคต่์อส่วนราชการ
ไดต้ั้งแต่วนัท่ี 1-15 ธนัวาคม ของทุกปี ซ่ึงจะมีผลส าหรับการรับเงินเดือนหรือคา่จา้งตั้งแต่เดือนมกราคมปีถดัไป 
โดยใชแ้บบแสดงความประสงคข์อเปล่ียนแปลงการรับเงินเดือนของขา้ราชการ (แบบ 2 ขรก.) และแบบแสดงความ
ประสงคข์อเปล่ียนแปลงการรับค่าจา้งของลูกจา้งประจ า (แบบ 2 ลจ.) ยื่นต่อเจา้หนา้ท่ีของส่วนราชการ  
เพื่อบนัทึกการเปล่ียนแปลงในระบบ e-Payroll ตั้งแต่วนัท่ี 1-31 ธนัวาคม 2567 หากพน้ระยะเวลาท่ีก าหนด ระบบ
จะปิดไม่ใหบ้นัทึกรายการได ้
 อยา่งไรก็ตาม การปรับการจ่ายเงินเดือนและค่าจา้งประจ า 2 รอบ เป็นทางเลือกส าหรับขา้ราชการและ
ลูกจา้งประจ าท่ีรับเงินเดือนและค่าจา้งประจ าผา่นระบบจ่ายตรงเงินเดือนและค่าจา้งประจ าของกรมบญัชีกลาง 
(ระบบ e-Payroll) เท่านั้น ไม่รวมการจ่ายเบ้ียหวดับ านาญของผูรั้บบ านาญ และส าหรับผูท่ี้ไม่ประสงคจ์ะ
เปล่ียนแปลง ไม่ตอ้งยืน่แบบแสดงความประสงคแ์ต่อยา่งใด ขอเตือนภยัผูรั้บบ านาญอยา่หลงเช่ือมิจฉาชีพท่ีแอบอา้ง
เป็นเจา้หนา้ท่ีจากกรมบญัชีกลางหรือเจา้หนา้ท่ีของรัฐ โทรหาและแจง้เร่ืองการจ่ายเงินเดือนหรือบ านาญ 2 รอบ 
แลว้ใหด้ าเนินการต่างๆ เช่น สอบถามความคิดเห็นวา่เห็นดว้ยหรือไม่ แลว้ใหก้ด 9 เป็นตน้ อยา่กดและอยา่
ด าเนินการใดๆ เพราะกรมบญัชีกลางไม่มีนโยบายส่งขอ้ความหรือโทรศพัทห์าผูรั้บบ านาญเพ่ือใหด้ าเนินการใดๆ 
เก่ียวกบัการจ่ายบ านาญ 2 รอบ หากมีขอ้สงสัยสามารถสอบถามขอ้มูลเพ่ิมเติมไดท่ี้ Call Center กรมบญัชีกลาง  
02 270 6400 ในวนัและเวลาราชการ. 
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 ISAT กบับทบาทส าคัญตลอด 30 ปี มุ่งผลกัดันการศึกษานานาชาติไทยสู่เวทีระดบัโลก 
 สมาคมโรงเรียนนานาชาติแห่งประเทศไทย (ISAT) เฉลิมฉลองครบรอบ 30 ปี จดักิจกรรมพิเศษสร้างความ
เขา้ใจความหลากหลาย พร้อมตอกย  ้าบทบาทส าคญั ท าหนา้ท่ีเป็นกระบอกเสียงใหแ้ก่การศึกษานานาชาติในไทย  
การเติบโตของโรงเรียนนานาชาติในประเทศไทยมีแนวโนม้เพ่ิมข้ึนอยา่งต่อเน่ือง ปัจจุบนัมีชาวต่างชาติท่ีอาศยัอยู่
ในประเทศไทยและครอบครัวไทยใหค้วามสนใจส่งบุตรหลานเขา้ศึกษาต่อในโรงเรียนนานาชาติมากข้ึนและถือได้
วา่ประเทศไทยเป็นศูนยก์ลางการศึกษานานาชาติท่ีส าคญัในภูมิภาคเอเชียตะวนัออกเฉียงใต ้ซ่ึงทางสมาคมโรงเรียน
นานาชาติแห่งประเทศไทย (ISAT) มีบทบาทส าคญัอยา่งมากในเร่ืองน้ี 
 โดยในปี 2567 ทางสมาคมฯ ไดเ้ฉลิมฉลองครบรอบ 30 ปีของการมีส่วนร่วมในการเติบโตของการศึกษา
นานาชาติในประเทศไทย จากจุดเร่ิมตน้ดว้ยโรงเรียนสมาชิกเพียง 5 แห่ง จนถึงปัจจุบนั สมาคมฯ ไดเ้ติบโตข้ึนจนมี
โรงเรียนสมาชิกเกือบ 200 แห่งทัว่ประเทศ โดยมีจ านวนนกัเรียนกวา่ 85,000 คนจากหลากหลายเช้ือชาติและ
วฒันธรรม เพ่ิมข้ึน 24.7% นบัตั้งแต่ปี 2565  คุณอุษา สมบูรณ์ นายกสมาคมฯ กล่าววา่ สมาคมฯ ท าหนา้ท่ีเป็น
ศูนยก์ลางการประสานความร่วมมือระหวา่งโรงเรียนสมาชิกทัว่ประเทศ สร้างเครือข่ายโรงเรียนนานาชาติท่ีมี
คุณภาพ สนบัสนุนใหผู้เ้รียนไดรั้บการศึกษาท่ีครอบคลุมและมีคุณภาพระดบัสากล เพ่ือพฒันาศกัยภาพและ 
ทกัษะส าหรับการเผชิญหนา้กบัโลกท่ีเปล่ียนแปลงอยูต่ลอดเวลา 
 "ในวนัท่ี 23 พฤศจิกายน 2567 จะมีการฉลองครบรอบ 30 ปีของสมาคมฯ มีการจดักิจกรรมพิเศษเชิญ
วิทยากรช่ือดงัระดบัโลกมาใหค้วามรู้เก่ียวกบั DEIB วา่จะท าอยา่งไรใหน้กัเรียนในโรงเรียนรู้สึกวา่ตวัเองเป็นส่วน
หน่ึงในกลุ่มเพ่ือน โรงเรียน และชุมชนท่ีเขาอยู ่เพราะเด็กมาจากหลายเช้ือชาติจึงมีวฒันธรรมความเช่ือ การเล้ียงดู
ของพ่อแม่ท่ีแตกต่างกนั ดงันั้นจึงตอ้งมาท าความเขา้ใจร่วมกนั เพ่ือใหทุ้กคนเคารพในความแตกต่าง ซ่ึงเร่ืองน้ีเราท า
มาโดยตลอด การจดักิจกรรมในคร้ังน้ีเพ่ือใหค้นท่ีเขา้ใจอยูแ่ลว้ มีความเขา้ใจมากข้ึน เห็นความส าคญัมากข้ึนแลว้
น าไปพฒันาต่อ" 
 ความร่วมมือ ISAT กับภาครัฐ 
 ส าหรับการมีส่วนร่วมกบัภาครัฐ ท่ีผา่นมาทางสมาคมฯ มีความร่วมมืออยา่งใกลชิ้ดกบัหน่วยงานภาครัฐ
ต่างๆ เป็นเหมือนสะพานเช่ือมใหก้บัภาครัฐส่ือสารกบัโรงเรียนนานาชาติ เพ่ือใหแ้น่ใจวา่โรงเรียนสมาชิก
ด าเนินการสอดคลอ้งกบันโยบายของภาครัฐ ไม่วา่จะเป็น กระทรวงศึกษาธิการ กระทรวงการต่างประเทศ 
กระทรวงแรงงาน กระทรวงการอุดมศึกษา วิทยาศาสตร์ วิจยัและนวตักรรม คุรุสภา ส านกังานตรวจคนเขา้เมือง 
ส านกังานรับรองมาตรฐานและคุณภาพการศึกษาแห่งชาติ (ONESQA) และหน่วยงานรับรองมาตรฐานท่ีไดรั้บการ
ยอมรับในระดบัสากล การท างานร่วมกนัน้ีช่วยสร้างความเขา้ใจท่ีดีในเชิงนโยบายและการปฏิบติั ตลอดจนเป็นการ
สร้างมาตรฐานร่วมกนัของโรงเรียนนานาชาติทัว่ประเทศ โดยเฉพาะอยา่งยิง่ในการรองรับมาตรฐานระดบัสากล 
รวมทั้งท าหนา้ท่ีประสานงานกบัหน่วยงานการศึกษาต่างประเทศเพ่ือประยกุตแ์นวทางการจดัการเรียนรู้ท่ี
หลากหลายและเหมาะสมส าหรับนกัเรียนในประเทศไทย 
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 คุณอุษา สมบูรณ์ นายกสมาคมฯ กล่าวอีกวา่ นอกจากน้ีเรายงัมีส่วนร่วมในการร่างกฎหมายการศึกษา
แห่งชาติ ซ่ึงตอ้งขอบคุณท่านกรรมาธิการท่ีใหโ้อกาสเขา้ไปแสดงความคิดเห็นวา่คุณภาพการศึกษาควรเป็นแบบใด 
ซ่ึงเราอยากใหมี้การกระจายอ านาจลงมาท่ีโรงเรียนใหม้ากท่ีสุด เนน้ใหก้ารศึกษาเด็กเลก็ไปจนถึงอาย ุ6 ขวบ 
เน่ืองจากช่วงวยัน้ีเป็นช่วงท่ีสมองขยาย มีความคิดสร้างสรรคสู์งมาก หากเด็กอยูใ่นส่ิงแวดลอ้มท่ีเอ้ือต่อส่ิงน้ีเขาก็จะ
โตไปเป็นคนท่ีมีความคิดสร้างสรรค ์นอกจากน้ี สมาคมฯ ยงัเป็นเหมือนตวัแทนใหก้บัโรงเรียนนานาชาติท่ีเขา้ไป
ช่วยแกปั้ญหาต่างๆ เวลามีเหตุการณ์ท่ีไม่คาดคิด อยา่งเช่น การระบาดของโควิด-19 ในเร่ืองของการท างานของครู
ชาวต่างชาติช่วงประกาศปิดประเทศ รวมไปถึงการมีส่วนร่วมออกความเห็นเก่ียวมาตรการป้องกนัโควิดในโรงเรียน 
 ขณะเดียวกนั สมาคมฯ ยงัมุ่งมัน่พฒันานกัเรียนท่ีมีความเป็นเลิศทางวิชาการและพร้อมท่ีจะเป็นพลเมือง
โลก โดยเนน้การส่งเสริมความรับผิดชอบต่อสังคมและส่ิงแวดลอ้มตามแนวทางของเป้าหมายการพฒันาท่ีย ัง่ยนื
ของสหประชาชาติ (SDGs) โรงเรียนสมาชิกของ ISAT สร้างสภาพแวดลอ้มการเรียนรู้ท่ีปลูกฝังใหน้ักเรียนมี
ความคิดเชิงสร้างสรรค ์มีจิตส านึกในการอนุรักษท์รัพยากรธรรมชาติ และส่งเสริมใหพ้วกเขาตระหนกัถึงบทบาท
ของตนเองในฐานะพลเมืองโลกท่ีมีส่วนร่วมในการแกไ้ขปัญหาต่าง ๆ อยา่งย ัง่ยนื ทั้งยงัสร้างแรงบนัดาลใจให้
ผูเ้รียนเป็นผูรั้กการเรียนรู้ตลอดชีวิต กา้วทนัเทรนดก์ารเปล่ียนผา่นในยคุดิจิทลั และเป็นนกันวตักรรมท่ีมีความเห็น
อกเห็นใจเพื่อนมนุษย ์
 เม่ือถามถึงความคาดหวงัของผูป้กครองต่อโรงเรียนนานาชาติ คุณภทัราดา ยมนาค อุปนายกสมาคมฯ และ
ผูอ้  านวยการโรงเรียนนานาชาติ เปิดเผยวา่ เหตุผลท่ีผูป้กครองส่งลูกมาศึกษาท่ีโรงเรียนนานาชาติก็คือ "ภาษา" อยา่ง
แรกคือ ภาษาองักฤษ ซ่ึงในโรงเรียนนานาชาติจะะมีภาษาอ่ืนใหเ้ด็กไดเ้รียนดว้ย ฉะนั้นเด็กจะได ้3 ภาษา และ 
ส่ิงส าคญัคือเด็กยงัไดอ้ยูก่บัครอบครัว 
 อีกประการคือพ่อแม่ไม่อยากใหลู้กเรียนแบบทอ่งจ า แต่อยากใหลู้กอยูใ่นระบบท่ีสามารถคิดเอง มีความ
เขา้ใจ แลว้ก็วิเคราะห์แกปั้ญหาได ้ต่อมาคือการแข่งขนั ในการเรียนสมยัก่อนจะมีการแข่งขนัตั้งแต่ก่อนเรียนอนุบาล 
เพ่ือเขา้โรงเรียนอนุบาลท่ีดี ไปจนถึงการแข่งขนัเขา้มหาวิทยาลยั โดยส่วนใหญ่พ่อแม่จะสนบัสนุนใหลู้กเรียนพิเศษ 
แต่ในปัจจุบนัโรงเรียนนานาชาติไดเ้ปิดหลกัสูตรนานาชาติในมหาวิทยาลยัมากข้ึนและมีการประกนัคุณภาพ ดงันั้น
พ่อแม่ท่ีสงสารลูกเรียนพิเศษจึงเลือกส่งลูกเรียนหลกัสูตรนานาชาติ รวมทั้งยงัสอนใหเ้ด็กกลา้ตดัสินใจ หาก
ตดัสินใจพลาดแลว้ก็ตอ้งลุกข้ึนมาได ้ไม่หมดก าลงัใจ สามารถแกไ้ขปรับปรุงเพ่ือพฒันาใหดี้ข้ึน 
 คุณปรัญ อินทพนัธุ์ กล่าวเสริมวา่ ส่ิงท่ีผูป้กครองค่อนขา้งคาดหวงัคือ ส่ิงแวดลอ้มท่ีเอ้ือต่อการเรียนรู้ หรือ
การใหเ้ด็กไดค้น้หาตวัเองเจอวา่ชอบอะไร สนใจอะไร 
 "ก่อนจะสมคัรเขา้โรงเรียนนานาชาติจะมีการพาทวัร์โรงเรียนก่อน ซ่ึงตวัช้ีวดัวา่ผูป้กครองจะตดัสินใจเลือก
โรงเรียนไหนก็คือ ส่ิงแวดลอ้ม และส่ิงท่ีโรงเรียนมอบให ้เช่น หอ้งเรียนหลายๆ แบบเพ่ือใหเ้ด็กไดล้องฝึกหลายๆ 
อยา่ง หอ้งดนตรีท่ีมีมาตรฐาน กีฬาท่ีหลากหลาย เด็กๆ จะไม่ตอ้งเรียนวิชาการอยา่งเดียว แต่เขาจะไดฝึ้กทกัษะอ่ืน
ดว้ย ซ่ึงเราปลูกฝังใหเ้ขารู้จกัใชชี้วิตท่ีบาลานซ์ในอนาคต เป็นคนท่ีครบถว้น เม่ือถึงเวลาท่ีเขาออกจากอกพ่อแม่ไป
ใชชี้วิตของเขาเอง เขาจะมีพ้ืนฐานท่ีไดรั้บการหล่อหลอมมา พ่อแม่ก็จะสบายใจ" 
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 นายกฯ ถก 40 นักธุรกจิสหรัฐฯ - อาเซียน ย า้ Soft Power หนุนถ่ายหนังในไทยคืนเงิน 30% 
 “นายกฯ อ๊ิงค”์ ตอ้นรับ 40 นกัธุรกิจจากสภาธุรกิจสหรัฐอเมริกา-อาเซียน ย  ้าพร้อมหนุนอุตสาหกรรม
ภาพยนตร์ใหม้าถ่ายท าในไทย สนบัสนุนเงินคืน 30% ดา้นทูตสหรัฐฯ บอกการร่วมมือคร้ังน้ีสร้างงานนบัหม่ืน 
 วนัท่ี 27 พ.ย. 2567 ท่ีหอ้งสีม่วง ตึกไทยคู่ฟ้า ท าเนียบรัฐบาล น.ส.แพทองธาร ชินวตัร นายกฯ พบปะหารือ
กบัคณะนกัธุรกิจจากสภาธุรกิจสหรัฐอเมริกา-อาเซียน ท่ีน าโดยนายโรเบิร์ต โกเดค เอกอคัรราชทตูสหรัฐฯ ประจ า
ประเทศไทย และนายไบรอนั แมค็ฟีเตอร์ส รองประธานอาวโุส และกรรมการผูจ้ดัการระดบัภูมิภาค สภาธุรกิจ
สหรัฐฯ - อาเซียน และผูแ้ทนบริษทัสมาชิก จ านวนกวา่ 40 บริษทั ครอบคลุมในธุรกิจพลงังาน สาธารณสุข 
เทคโนโลยดิีจิทลั การท่องเท่ียวและเศรษฐกิจสร้างสรรค ์โดยน.ส.แพทองธาร ไดก้ล่าวถึงการเยอืนนคร
ลอสแอนเจลิส ท่ีผา่นมาวา่ไดเ้ชิญชวนใหเ้อกชนสหรัฐฯ เก่ียวกบัอุตสาหกรรมในอนาคต และอุตสาหกรรม
ภาพยนตร์ใหม้าถ่ายท าในไทย โดยมีนโยบายสนบัสนุนเงินคืน 30% ส าหรับการถ่ายท าภาพยนตร์ในประเทศไทย 
และสัปดาห์ท่ีผา่นมาไดส้นทนาทางโทรศพัทก์บันายโดนลัด ์เจ ทรัมป์ วา่ท่ีประธานาธิบดีสหรัฐอเมริกา ซ่ึงนาย
ทรัมป์ ไดแ้สดงความยนิดีกบัพฒันาการในเชิงบวกของไทย โดยเฉพาะการเติบโตทางเศรษฐกิจท่ีก าลงัเพ่ิมข้ึน 
พร้อมทั้งย  ้าถึงนโยบาย “Soft Power” ท่ีมุ่งพฒันาความร่วมมือในทุกภาคอุตสาหกรรม และไทยหวงัจะแลกเปล่ียน
ความรู้กบัผูเ้ช่ียวชาญจากสหรัฐฯ ในการพฒันาองคค์วามรู้ในดา้นต่างๆ ดา้นนายโรเบิร์ต กล่าววา่การหารือกบั 
น.ส.แพทองธาร ในวนัน้ีมีนกัธุรกิจจากหลากหลายภาคส่วนท่ีมีมูลค่าทางการคา้รวมกนัเป็นพนัลา้นดอลลาร์สหรัฐ 
คาดวา่จะช่วยสนบัสนุนการลงทุนและสร้างงานนบัหม่ืนคนในประเทศไทย โดยก่อนหนา้น้ีคณะ USABC  
ไดมี้การประชุมกบัรัฐมนตรีของไทยหลายท่าน ไดผ้ลท่ีน่าพอใจ เป็นการตอกย  ้าความเป็นหุน้ส่วนไทย-สหรัฐฯ  
ทั้งการคา้และการลงทุน รวมถึงความร่วมมือในทุกระดบัและขอช่ืนชมนโยบายของรัฐบาลท่ีใหค้วามส าคญักบั
ภาคเอกชน รวมถึงนโยบายของรัฐบาลในการอ านวยความสะดวกในการลงทุน (Ease of Doing Business)  
การส่งเสริมเศรษฐกิจอยา่งย ัง่ยนื และการส่งเสริมการใชดิ้จิทลัในดา้นการคา้และการลงทุน รวมถึงภาคการเงิน  
และพร้อมร่วมมือกบัรัฐบาลในการกระชบัความสัมพนัธ์ทางดา้นการคา้และการลงทุนร่วมไทยและสหรัฐฯ ต่อไป 
 กระทรวงพลงังาน ลดค่าไฟลงเหลือ 4.15 บาทต่อหน่วย มอบของขวัญปีใหม่ให้คนไทย 
 “พีระพนัธุ์ สาลีรัฐวิภาค” เผย กระทรวงพลงังาน ประกาศลดค่าไฟฟ้างวดม.ค.-เม.ย. 2568 ลงอีก 3 สตางค/์
หน่วย ลดค่าไฟลงเหลือ 4.15 บาทต่อหน่วย มอบของขวญัปีใหม่ใหค้นไทย วนัท่ี 27 พ.ย. 2567 นายพีระพนัธุ์ สาลี
รัฐวิภาค รองนายกรัฐมนตรีและรมว.พลงังาน เปิดเผยวา่ กระทรวงพลงังานจะประกาศลดค่าไฟฟ้างวดม.ค.-เม.ย. 
2568 จากค่าไฟฟ้าเฉล่ียในงวดปัจจุบนั (ก.ย.-ธ.ค. 2567) ซ่ึงอยูท่ี่ 4.18 บาท/หน่วย ลงอีก 3 สตางค/์หน่วย หรือค่า
ไฟฟ้าจะลดลงเหลือ 4.15 บาท/หน่วย โดยจะมีผลตั้งแต่เดือน ม.ค.-เม.ย. 2568 ทั้งน้ีเพ่ือช่วยบรรเทาภาระค่าครองชีพ
และเป็นของขวญัปีใหม่ 2568 ใหก้บัพ่ีนอ้งชาวไทยทุกคน 
 “ผมเพ่ิงไดรั้บแจง้เบ้ืองตน้เป็นขา่วดีจากทางส านกังาน กกพ. ซ่ึงจะปรับลดค่าไฟในงวดหนา้ (ม.ค.-เม.ย. 
2568) ลงไดอี้ก และเหลือเฉล่ียหน่วยละ 4.15 บาท หลงัจากท่ีผมไดข้อใหทุ้กหน่วยงานไดไ้ปลองดูวา่จะสามารถลด
ค่าไฟลงไดอี้กหรือไม่ เพ่ือบรรเทาภาระคา่ครองชีพใหพ่ี้นอ้งประชาชน ในนามรัฐบาลและกระทรวงพลงังานขอถือ
โอกาสน้ีมอบเป็นของขวญัปีใหม่ใหก้บัทุกท่าน และขอขอบคุณ กกพ.ในฐานะหน่วยงานหลกัขอบคุณ การไฟฟ้า
ฝ่ายผลิตแห่งประเทศไทย (กฟผ.) และปตท.ในการร่วมกนักบัรัฐบาลช่วยเหลือพ่ีนอ้งประชาชน” นายพีระพนัธุ์
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กล่าว ภายหลงัจากส้ินสุดกระบวนการรับฟังความคิดเห็นในการประชุมคณะกรรมการก ากบักิจการพลงังาน (กกพ.) 
ในวนัน้ี (27 พ.ย.) ไดมี้มติเห็นชอบทบทวนค่าไฟฟ้าผนัแปร (ค่าเอฟที) และค่าไฟฟ้าเรียกเก็บงวดเดือนม.ค.-เม.ย. 
2568 โดยใหเ้รียกเก็บลดลงเหลือ 4.15 บาทต่อหน่วย เป็นผลจากการท่ีไดมี้การทบทวนตวัเลข และประมาณการท่ี
เก่ียวขอ้ง ซ่ึง กกพ.จะไดมี้การประกาศอยา่งเป็นทางการต่อไป 
 เผยเหลีย่มไบเดน ไฟเขียวสัญญาค้าอาวุธให้อสิราเอล 680 ล้าน ขณะผลกัดันข้อตกลงหยุดยิงอสิราเอล -
เลบานอน 
 เผยรายละเอียดขอ้ตกลง "โจ ไบเดน" ไฟเขียวขายอาวธุใหอิ้สราเอล 680 ลา้นดอลลาร์สหรัฐ ในขณะท่ีก าลงั
ช่วยผลกัดนัท าขอ้ตกลงหยดุยงิอิสราเอลกบัเลบานอน และยงัใหค้  ามัน่วา่จะช่วยใหเ้กิดขอ้ตกลงหยดุยงิในกาซาดว้ย 
คาดอิสราเอลยอมรับเง่ือนไขหยดุยงิเพราะจะไดอ้าวธุใหม่รวมไปถึงชุดอุปกรณ์น าวิถี ส าหรับติดระเบิดไปถล่มกลุ่ม
ฮามาส ในกาซา วนัท่ี 27 พฤศจิกายน 2567 เวบ็ไซตข์่าวเดอะ ไฟแนนเชียล ไทมส์ รายงานวา่ รัฐบาลของ
ประธานาธิบดีโจ ไบเดน ของสหรัฐฯ ไดอ้นุมติัแพค็เกจขายอาวธุมูลค่า 680 ลา้นดอลลาร์สหรัฐ หรือประมาณ 
23,400 ลา้นบาท ใหแ้ก่อิสราเอล โดยท่ีรัฐบาลไบเดนยงัท าหนา้ท่ีผลกัดนัใหเ้กิดสันติภาพในตะวนัออกกลาง 
 โดยการเปิดเผยเก่ียวกบั ขอ้ตกลงดา้นอาวธุระหวา่งสหรัฐฯกบัอิสราเอล มีข้ึนเพียง 1 วนัหลงัจาก
ประธานาธิบดีไบเดนออกมาประกาศขอ้ตกลงหยดุยงิระหวา่งอิสราเอลและกลุ่มฮิซบอลเลาะห์ ในเลบานอน พร้อม
ใหค้  ามัน่วา่จะฟ้ืนฟูความพยายามในการบรรลุขอ้ตกลงท่ีคลา้ยกนัน้ี ระหวา่งอิสราเอลและกลุ่มฮามาส ในพ้ืนท่ี
ฉนวนกาซา ซ่ึงหลายฝ่ายเคยพยายามมาหลายรอบแลว้แต่ก็ไม่เป็นผล ขณะเดียวกนัเจา้หนา้ท่ีสหรัฐฯ ท่ีไม่เปิดเผยช่ือ
รายหน่ึงเปิดเผยกบัส านกัข่าวรอยเตอร์วา่ แพค็เกจขายอาวธุน้ีอยูใ่นระหวา่งด าเนินการมาหลายเดือนแลว้ และไดมี้
การพิจารณาโดยคณะกรรมการของรัฐสภาในเดือนกนัยายน และไดถู้กส่งใหพิ้จารณาเป็นวงกวา้งในเดือนตุลาคม 
 ทั้งส านกัข่าวรอยเตอร์ และไฟแนนเชียลไทมส์ รายงานวา่ การส่งมอบอาวธุยทุโธปกรณ์ใหก้บัอิสราเอลคร้ัง
ล่าสุด จะรวมถึงระเบิดขนาดเลก็หลายร้อยลูก และชุดอุปกรณ์น าวิถี (Joint Direct Attack Munition) หรือ JDAM 
จ านวนหลายพนัชุด ส าหรับติดตั้งกบัระเบิดทัว่ไปเพ่ือใหก้ลายเป็นอาวธุน าวิถีแม่นย  า 
 อยา่งไรก็ตาม รัฐบาลของนายไบเดนยงัไม่ไดย้นืยนัรายงานข่าวน้ี โดยท่ีผา่นมา ประธานาธิบดีไบเดนมองวา่ 
การขายอาวธุใหอิ้สราเอลเป็นการสนบัสนุนท่ีส าคญัส าหรับพนัธมิตร แต่ขณะเดียวกนัก็เนน้ย  ้าถึงจุดยนืของสหรัฐฯ 
เก่ียวกบัความขดัแยง้ในตะวนัออกกลาง และผลกัดนัใหอิ้สราเอลกบัเลบานอน ท าขอ้ตกลงหยดุยงิ 
 ทั้งน้ี จนถึงปัจจุบนั อิสราเอลสังหารชาวปาเลสไตน์ในฉนวนกาซา ไปแลว้อยา่งนอ้ย 44,282 ศพ นบัตั้งแต่
สงครามการลา้งแคน้ไดเ้ร่ิมตน้ข้ึนเม่ือกลุ่มฮามาสบุกโจมตีอิสราเอล ซ่ึงท าใหมี้ผูเ้สียชีวิตอยา่งนอ้ย 1,139 ศพ 
ขณะเดียวกนักองทพัอิสราเอลสังหารชาวเลบานอนไปแลว้มากกวา่ 3,800 ศพในช่วง 13 เดือนท่ีผา่นมา. 
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 แนวข้อสอบความรู้ความสามารถทางด้านคอมพวิเตอร์  
(การใช้งานโปรแกรมพืน้ฐาน Microsoft Office) 

แนวข้อสอบ Microsoft Word 

1. Microsoft Word 2010 ถา้ตอ้งการบนัทึกเอกสารเพื่อใหส้ามารถเปิดใน Word เวอร์ชนัก่อนหนา้ไดจ้ะบนัทึก
เป็นแบบใด 
  1. บนัทึกเอกสารในรูปแบบไฟล ์.docx 2. บนัทึกเอกสารในรูปแบบไฟล ์.doc 
  3. บนัทึกเอกสารในรูปแบบไฟล ์.dox 4. บนัทึกเอกสารในรูปแบบไฟล ์.dog  
2. หากตอ้งการแกค้  าผิดทุกค า ใน Microsoft Word เพียงคร้ังเดียว ตอ้งไปท่ีค าส่ังใดบา้ง 
  1. Home → Replace 2. Ctrl + H 
  3. F5→ Replace 4. ถูกทุกขอ้   
3. ถา้ตอ้งการตั้งค่าหนา้กระดาษแบบแนวนอน ไปท่ีค าส่ังในขอ้ใด 
  1. Page Layout → Orientation → Portrait 
  2. Page Layout → Orientation → Landscape 
  3. Page Layout → Margins → Portrait 
  4. Page Layout → Margins → Landscape  
4. การใชโ้ปรแกรม Microsoft Word การคลิกปุ่ ม Ctrl กบัปุ่ มลูกศรข้ึนบน ( ) มีผลท างานตรงกบัขอ้ใด 
  1. เล่ือนไปทา้ยเอกสาร 2. เล่ือนไปยอ่หนา้ถดัไป 
  3. เล่ือนไปกลางเอกสารในกลุ่มนั้น 4. เล่ือนไปท่ียอ่หนา้ก่อนหนา้นั้น 
5. การใชโ้ปรแกรม Microsoft Word ขอ้ใดคือขั้นตอนการแปลงตารางขอ้มูลใหแ้สดงผลแบบไม่มีตาราง และมี
การแบ่งระยะแทบ็ 
  1. เลือกเมนูค าส่ัง Layout → Convert To Text → Tabs 
  2. เลือกเมนูค าส่ัง Insert → Table To Text → Tabs 
  3. เลือกเมนูค าส่ัง Table → Table To Text → Tabs 
  4. เลือกเมนูค าส่ัง Table → Split Table → Table To Text → Tabs  
6. ในโปรแกรม Microsoft Word การด าเนินการ Mail Merge หมายถึงขอ้ใด 
   1. การรวบรวมค าส่ังการด าเนินงานท่ีเก่ียวกบั E-mail 
   2. การจดัส่ง E-mail ภายใตโ้ปรแกรม Microsoft Word 
   3. การจดัท าขอ้ความท่ีมีเน้ือหาเดียวกนั แตกต่างกนัเพียงบางอยา่ง 
   4. การเช่ือมโยงหรือเปิดขอ้มูลจาก File อ่ืนๆ  
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7. การปรับปรุงแบบงานขอ้มูลประเภทตารางใหเ้ป็นอกัษรชนิด  Cordia New  ตอ้งใชข้ั้นตอนในขอ้ใด 
  1. คลิกท่ีก่ึงกลางคอลมัน์ของตาราง → เลือกค าส่ังเปล่ียนรูปแบบอกัษร 
  2. คลิกท่ีมุมขวาล่างของตาราง → เลือกค าส่ังเปล่ียนรูปแบบอกัษร 
  3. คลิกท่ีก่ึงกลางแถวของตาราง → เลือกค าส่ังเปล่ียนรูปแบบอกัษร  
  4. คลิกท่ีมุมซา้ยบนของตาราง → เลือกค าส่ังเปล่ียนรูปแบบอกัษร  
8. Bring to Front มีความหมายในลกัษณะใด 
  1. น าภาพท่ีเลือกไปวางไวห้นา้สุด 2. น าภาพแทรกอยูใ่นบรรทดัของขอ้ความ 
  3. น าภาพท่ีเลือกไวห้ลงัขอ้ความ 4. น าภาพท่ีเลือกไปไวห้ลงัสุด 
9. การผสานเซลล ์(Merge Cells) นั้นตอ้งใชข้ั้นตอนการท างานในขอ้เลือกใด 
  1. คลิกคอลมัน์ท่ีตอ้งการ → คลิกเมาส์ขวา → เลือกค าส่ังผสานเซลล ์
  2. ดบัเบ้ิลคลิกคอลมัน์ท่ีตอ้งการ → คลิกเมาส์ขวา → เลือกค าส่ังผสานเซลล ์
  3. คลิกลากคลุมกลุ่มคอลมัน์ท่ีตอ้งการ → คลิกเมาส์ขวา → เลือกค าส่ังผสานเซลล ์
  4. กรอกจ านวนคอลมัน์ท่ีตอ้งการ → คลิกเมาส์ขวา → เลือกค าส่ังผสานเซลล ์  
10. งานในขอ้ใดท่ีไม่เป็นตวัเลือกใหใ้ชง้านในส่วนค าส่ัง Margins 
  1. ก าหนดแหล่งกระดาษ 2. ก าหนดระยะขอบกระดาษ 
  3. ก าหนดระยะเยบ็กระดาษ 4. ก าหนดการวางแนวกระดาษ  
11. หากน าเอกสารเก่ามาปรับแกไ้ขเป็นเอกสารใหม่และตอ้งการบนัทึกเป็นเอกสารช่ือใหม่ ตอ้งใช ้
ขั้นตอนขอ้ใด 
   1. ค าส่ัง File → Save → ช่ืองานใหม่ 
   2. ค าส่ัง File → Save as → ช่ืองานใหม่ 
   3. ค าส่ัง File → Save all → ช่ืองานใหม่ 
   4. ค าส่ัง File → Save document    → ช่ืองานใหม่ 
12. กรณีท่ีเอกสารมีเลขล าดบัอตัโนมติั  (เช่น 1, 2, 3 ....)   หากตอ้งการเปล่ียนล าดบัเป็นรูปแบบอ่ืนตอ้งใชค้  าส่ัง
ใด 
  1. ค าส่ัง Bullets 2. ค าส่ัง Symbols 
  3. ค าส่ัง Style 4. ค าส่ัง Paragraph 
13. Microsoft word มุมมองขอ้ใดท่ีแสดงหวัขอ้ 
  1. Outline View 2. Draft View 
  3. Web Layout 4. Full Screen Reading 
14. ขอ้ใด คือ ความสามารถของโปรแกรม Microsoft Word 
  1. สามารถแทรกรูปภาพ กราฟ หรือผงัองคก์รลงในกระดาษได ้
  2. สามารถสร้างตารางลงในเอกสารได ้
  3. มีตวัช่วยในการสร้างฟอร์มของจดหมายไดห้ลายรูปแบบ 
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  4. ถูกทุกขอ้ 
15. ถา้ตอ้งการลบตวัอกัษรท่ีอยูห่ลงั  Cursor  ตอ้งใชปุ้่ มใด 
  1. Space Bar  
  2. Delete 
  3. Backspace  
  4. Caps Lock 
16. เม่ือท่านตอ้งการแทรกรูปภาพตอ้งใชค้  าส่ังใด 
  1. Insert  Picture 2. References  Picture 
  3. Insert  Symbol 3. References  Symbol 
17. เม่ือพบวา่ในจดหมายเวยีน มีการกรอกขอ้มูลผิด เช่น สะกดช่ือผูรั้บผิดตอ้งท าอยา่งไร 
  1. คลิกท่ี ไม่รวมผูรั้บรายช่ือน้ี 2. คลิกท่ี แกไ้ขรายช่ือผูรั้บ 
  3. คลิกท่ี ถดัไป 4. คลิกท่ี ก่อนหนา้ 
18. ขอ้ใดกล่าวไดถู้กตอ้ง 
  1. เม่ือตอ้งการตั้งค่าการพิมพเ์อกสารใหก้ด Ctrl+ P 
  2. เม่ือตอ้งการพิมพเ์อกสารในหนา้ 11-17 และ 20 ตอ้งป้อนตวัเลข 11-17+20 
  3. การกั้นหนา้กั้นหลงั หมายถึง การก าหนดรูปแบบการพิมพ ์
  4. เม่ือกดเรียกดูเอกสารก่อนพิมพ ์ไม่สามารถแสดงรูปภาพในเอกสารได ้
19. ขอ้ใดกล่าวถูก 
  1. ระยะ Margins คือ ระยะระหวา่งขอบกระดาษกบัขอ้ความในเอกสาร 
  2. เม่ือเปล่ียนขนาดกระดาษจาก A4 เป็น B5 จ านวนหนา้ในเอกสารจะเพ่ิมมากข้ึน 
  3. การสร้างส าเนาเอกสารอตัโนมติั ใช ้คลิกเมนู File  Option แลว้ คลิกแถบ Save  
และเลือกเคร่ืองหมายถูกท่ี Save Auto Recover information 
  4. ถูกทุกขอ้ 
20. ถา้ตอ้งการข้ึนหนา้ใหม่ เพราะตอ้งการข้ึนเร่ืองใหม่หรือบทใหม่ตอ้งท าอยา่งไร 
  1. กดคีย ์Enter 2. Insert  Page Break 
  3. Insert  Next Page 4. F11 

เฉลย MS – Word 
ขอ้ 1. 2 ขอ้ 6. 3 ขอ้ 11. 2 ขอ้ 16. 1 
ขอ้ 2. 4 ขอ้ 7. 4 ขอ้ 12. 4 ขอ้ 17. 2 
ขอ้ 3. 2 ขอ้ 8. 1 ขอ้ 13. 1 ขอ้ 18. 1 
ขอ้ 4. 4 ขอ้ 9. 3 ขอ้ 14. 4 ขอ้ 19. 4 
ขอ้ 5. 1 ขอ้ 10. 1 ขอ้ 15. 2 ขอ้ 20. 2 

………………………. 
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แนวข้อสอบ Microsoft Excel 

1. ในโปรแกรม Excel การพิมพว์นัจนัทร์ถึงวนัอาทิตยโ์ดยอตัโนมติั สามารถท าไดโ้ดยวิธีใด 
  1. พิมพว์นัจนัทร์แลว้ช้ีเมาส์ท่ีมุมล่างขวาของเซลลน์ั้นแลว้ลากลงไปอีก 6 ช่อง 
  2. พิมพว์นัจนัทร์แลว้ช้ีเมาส์ท่ีเซลลน์ั้นแลว้ลากลงไปอีก 6 ช่อง 
  3. พิมพว์นัจนัทร์แลว้ช้ีเมาส์ท่ีมุมล่างขวาของเซลลน์ั้นแลว้ลากลงไปอีก 5 ช่อง 
  4. พิมพว์นัจนัทร์แลว้ช้ีเมาส์ท่ีกลางเซลลน์ั้นแลว้ลากลงไปอีก 5 ช่อง  
2. สัญลกัษณ์ #REF! ท่ีปรากฏบนเซลลเ์กิดข้ึนเพราะสาเหตุใด 
  1. มีการก าหนดชนิดขอ้มูลท่ีใชใ้นสูตรค านวณผิด 
  2. มีการอา้งอิงกลุ่มเซลลท่ี์ไม่ถูกตอ้ง 
  3. เซลลท่ี์สูตรค านวณอา้งอิงถูกลบท าให ้Excel หาผลลพัธ์ไม่ได ้
  4. มีการอา้งอิงเซลลไ์ม่มี 
3. การใชโ้ปรแกรม Microsoft Excel เม่ือพบความผิดพลาด ##### บน Cell ใน Work Sheet ซ่ึงภายในเซลลมี์
ฟังกช์นัค านวณขอ้มูล หากตอ้งการแกไ้ขใหแ้สดงตวัเลขได ้ตอ้งใชว้ิธีการขอ้ใด 
  1. แกไ้ขสูตรท่ีอยูใ่น cell  
 2. ปรับเพ่ิมความกวา้งของสดมภ ์(Column) 
  3. แกไ้ขรูปแบบ Font  
 4. ปรับเพ่ิมความกวา้งของแถว (Row) 
4. การเลือกใชฟั้งกช์นั IF ในโปรแกรม Microsoft Excel ท าเพื่ออะไร 
  1. ค านวณผลรวมขอ้มูล 2. คน้หาขอ้มูลท่ีก าหนด 
  3. ตรวจสอบเง่ือนไขขอ้มลู 4. ค านวณค่าเฉล่ียขอ้มูล  
5. ขอ้ใดเป็นการบวกใน excel 
  1. =SUM(A1:A5)  2. =D3 * E2 
  3. A1 + A3 * A3  4. =SUM(A1A5) 
6. ถา้ตอ้งการตรึงแถวขอ้มูลจะใชว้ิธีการใด 
  1. คลิกเมาส์เลือกแถวขา้งบนแถวท่ีตอ้งการตรึง แลว้เลือกค าส่ัง Window  Freeze Panes 
  2. คลิกเมาส์เลือกแถวขา้งใตแ้ถวท่ีตอ้งการตรึง แลว้เลือกค าส่ัง Window  Freeze Panes 
  3. คลิกเมาส์เลือกแถวขา้งบนแถวท่ีตอ้งการตรึง แลว้เลือกค าส่ัง Freeze Panes 
  4. คลิกเมาส์เลือกแถวขา้งใตแ้ถวท่ีตอ้งการตรึง แลว้เลือกค าส่ัง Freeze Panes 
7. ในการใชโ้ปรแกรม Microsoft Excel หากตอ้งการก าหนดขอบเขตกลุ่มเซลลท์ างานแบบไม่ต่อเน่ืองจะตอ้งกด
ปุ่ มใดท่ีแป้นพิมพค์า้งไวก่้อนเลือกกลุ่มเซลลถ์ดัไป 
  1. ปุ่ ม < Page Up > 2. ปุ่ ม < Ctrl > 
  3. ปุ่ ม < Del > 4. ปุ่ ม < Esc > 
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8. การเลือกช่วงเซลลใ์หเ้ป็นเซลลท์ างานในโปรแกรม Microsoft Excel อาจเลือกพร้อมกนัไดห้ลายเซลลโ์ดยไม่
ติดกนั ท าไดใ้นขอ้ใด 
  1. คลิกท่ีเซลลแ์รก ใชปุ้่ มลูกศรไปยงัเซลลต่์อไป 
  2. คลิกท่ีเซลลแ์รกกดปุ่ ม Ctrl คา้งไว ้แลว้คลิกท่ีเซลลต่์อไป 
  3. คลิกท่ีเซลลแ์รก กดปุ่ ม Shift คา้งไว ้แลว้คลิกท่ีเซลลต่์อไป 
  4. คลิกเมาส์ท่ีช่องวา่งดา้นบนแถวท่ี 1 กบัดา้นซา้ยของคอลมัน์ A  
9. เม่ือเรากรอกขอ้ความแลว้ หากตอ้งการจะข้ึนบรรทดัใหม่ในเซลลเ์ดิมตอ้งท าอยา่งไร 
  1. กด Ctrl + Enter 2. กด Alt + Enter 
  3. กด Shift + Enter  4. กด Enter 
10. การกรอกวนัท่ีตอ้งใชเ้คร่ืองหมายใด คัน่กลางระหวา่งวนั เดือน ปี 
  1.   /   2.   : 
  3.   ,   4.   . 
11. การจดัรูปแบบถา้ตอ้งการใส่พ้ืนหลงั Work Sheet ท าไดต้ามขอ้ใด 
  1. View  Page Setup  Background 
  2. Insert  Page Setup  Background 
  3. Review  Page Setup  Background 
  4. Pave Layout  Page Setup  Background  
12. ขอ้ใดคือการเลือกเซลลท์ั้งหมดในเวิร์กชีท 
  1. เลือกเมาส์พอยเตอร์ไปยงัส่วนท่ีหมายเลขแถวและช่ือคอลมัน์มาบรรจบกนั ตรงมุมบนซา้ย แลว้คลิกเมาส์ 
1 คร้ัง 
  2. เล่ือนเมาส์พอยเตอร์ไปยงัต าแหน่งของเซลลแ์รก แลว้กดปุ่ ม คา้งไว ้แลว้เล่ือนเมาส์พอยเตอร์ไปคลิกยงั
ต าแหน่งสุดทา้ย แลว้จึงกดปุ่ ม 
  3. Ctrl + Z 
  4. Ctrl + F  
13. การพิมพสู์ตรค านวณสามารถพิมพล์งในช่องใดบา้ง 
  1. 1 ช่อง คือ ช่องเซลล ์(cells) 
  2. 2 ช่อง คือ ช่องแถบสูตร (Formula bar) และกล่องช่ือ (Name Box) 
  3. 2 ช่อง คือ ช่องเซลล ์(cells) กบัช่องแถบสูตร Formula bar 
  4. 3 ช่อง คือ ช่องเซลล ์(cells) ช่องแถบสูตร (Formula bar) และกล่องช่ือ (Name Box)  
14. เม่ือเปิดโปรแกรมข้ึนมา Excel จะมีแผน่งานเร่ิมตน้ใหเ้ท่าไร 
  1. 3 แผน่งาน 2.4 แผน่งาน 
  3. 5 แผน่งาน 4.6 แผน่งาน 
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15. ขอ้ใดกล่าวถึงการลบเวิร์กชีทออกจากเวิร์กบุ๊กไม่ถูกตอ้ง 
  1. ลบหลายเวิร์กชีทติดกนั ใหก้ดคีย ์ Alt  คา้งไวแ้ลว้คลิกเลือกทีละเวิร์กชีท 
  2. ลบหลายเวิร์กชีทท่ีไม่ติดกนั ใหก้ดคีย ์ Ctrl  คา้งไวแ้ลว้คลิกเลือกเวิร์กชีทท่ีตอ้งการ 
  3. ถา้จะลบทุกเวิร์กชีทใหค้ลิกขวาท่ีเวิร์กชีทใดก็ได ้แลว้เลือก  Select All Sheets 
  4. ถูกทุกขอ้ 

16.   จากรูป พ้ืนท่ีท่ีถูกเลือกคือขอ้ใดต่อไปน้ี 
  1. E11 : D14 2. E14 : D11 
  3. 11D : 14E 4. D11 : E14 

17.   เทคนิคการก็อปป้ีวนัท่ีใหมี้การกรอกขอ้มูลวนัท่ีใหม่อตัโนมติัดงัรูป เซลล ์ A3  จะมีขอ้มูลดงั
ขอ้ใด 
  1. 3/10/200 2. 3/09/2008 
  3. 2/09/2549 4. 2/10/2008 
18. การก าหนดรูปแบบขอ้มูลเลขบตัรประชาชน 13 หลกั ใหเ้ป็นเลขอารบิก ตอ้งก าหนดท่ีใด อยา่งไร 
  1. Home  Cell  Tab Number  Special  Identification Number 
  2. Home  Cell  Tab Number  Custom  Identification Number 
  3. Home  Cell  Tab Number  Number  Identification Number 
  4. Home  Cell  Tab Number  Scientific  Identification Number 
19. การก าหนดพ้ืนท่ีการพิมพเ์อกสาร ตอ้งใชเ้มนูใด 
   1. Page Layout  Print Preview  2.Page Layout  Page Setup 
   3. Page Layout  Print Area  4.Page Layout  Print 
20. ขอ้ใดไม่ใช่วิธีการแกไ้ขขอ้ความในโปรแกรม Excel 
   1. คลิกท่ีเซลลท่ี์จะแกไ้ข แลว้กดปุ่ ม F2 ท่ีคีบอร์ดจะเป็นการแกไ้ขในโหมด Edit 
   2. ดบัเบิ้ลคลิกตรงท่ีเซลลท่ี์จะแกไ้ขแลว้เล่ือนเคอร์เซอร์ไปแกไ้ขขอ้มูลภายในเซลลไ์ด ้
   3. คลิกตรงท่ีเซลลท่ี์จะแกไ้ขแลว้ดูท่ีแถบสูตร แลว้คลิกเมาส์ท่ีแถบสูตรเลยเพ่ือแกไ้ขขอ้มูล 
   4. คลิกท่ีแถบรูปแบบตวัอกัษรแลว้แกข้อ้ความท่ีพิมพผ์ิด 
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21. การพิมพซ์ ้ าแถวบนเพ่ือเป็นหวัตาราง ตอ้งใชเ้มนูใด 
   1. Page Layout  Page Setup  Page 
   2. Page Layout  Page Setup  Margin  Header 
   3. Page Layout  Page Setup  Header/Footer  Custom Header 
   4. Page Layout  Page Setup  Sheet  Row to repeat at top 
22. เม่ือตอ้งการแสดงคอลมัน์ท่ีซ่อนไว ้เช่น ซ่อนคอลมัน์ D มีวิธีการตามขอ้ใด 
  1. คลิกขวาท่ีแถบช่ือคอลมัน์ C  เลือกยกเลิกการซ่อน 
  2. ลากทึบท่ีคอลมัน์ C  คลิกขวา  คลิกยกเลิกการซ่อน 
  3. ลากทึบท่ีคอลมัน์ E  คลิกขวา  คลิกยกเลิกการซ่อน 
  4. ลากทึบท่ีคอลมัน์ C และ E  คลิกขวา  คลิกยกเลิกการซ่อน   
23. ถา้ส่ังใหโ้ปรแกรม Excel ค านวณเลขตามสูตร = 3 + 4 * 5  จะไดผ้ลลพัธ์ตามขอ้ใด 
  1. 60  2. 23 
  3. 27  4. 35 
24. IF, FALSE, AND, NOT, OR, TRUE เป็นฟังกช์นัประเภทใด 
  1. ฟังกช์นัเก่ียวกบัการเงิน 2. ฟังกช์นัแบบตรรกะ 
  3. ฟังกช์นัวนัท่ีและเวลา 4. ฟังกช์นัขอ้ความ  
25. ฟังกช์นัใดท่ีใชใ้นการค านวณเกรด 
  1. Lookup 2. COUNT 
  3. IF  4. COUNTIF 

เฉลย MS – Excel 
ขอ้ 1. 1 ขอ้ 6. 2 ขอ้ 11. 4 ขอ้ 16. 4 ขอ้ 21. 4 
ขอ้ 2. 3 ขอ้ 7. 2 ขอ้ 12. 1 ขอ้ 17. 4 ขอ้ 22. 4 
ขอ้ 3. 2 ขอ้ 8. 2 ขอ้ 13. 3 ขอ้ 18. 1 ขอ้ 23. 2 
ขอ้ 4. 3 ขอ้ 9. 2 ขอ้ 14. 1 ขอ้ 19. 3 ขอ้ 24. 2 
ขอ้ 5. 1 ขอ้ 10. 1 ขอ้ 15. 1 ขอ้ 20. 4 ขอ้ 25. 3 

…………………………. 
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แนวข้อสอบ Microsoft PowerPoint 
1. ในโปรแกรม Microsoft PowerPoint หากเลือกค าส่ัง Slide Show →  Custom Slide Show  
หมายถึงการด าเนินการใด 
  1. การน าเสนอภาพน่ิงแบบก าหนดเอง 
  2. การใชเ้สียงบรรยายประกอบงานท่ีน าเสนอ  
  3. การน าเสนองานผา่นเวบ็ไซด ์ 4. การสร้างภาพเคล่ือนไหว  
2. ขอ้ใดไม่ใช่ค าส่ังส าหรับจดัล าดบัของช้ินงาน (Object) ในการใชโ้ปรแกรม Microsoft PowerPoint 
   1. Send to Front 2.Send to Back 
   3. Bring to Front 4.Bring Forward  
3. วิธีการเปล่ียนหนา้สไลดร์ะหวา่งการน าเสนอให ้Slide Show ขอ้ใดไม่ถูกตอ้งในการใชโ้ปรแกรม  
Microsoft PowerPoint 
  1. คลิกท่ีค าส่ัง Insert 
  2. กดปุ่ ม Page up หรือ Page Down บนคียบ์อร์ด 
  3. เล่ือนท่ีลอ้ของเมาส์ 4. คลิกเมาส์ซา้ยท่ีหนา้สไลด ์
4. ขอ้ใดคือขั้นตอนการคดัเลือก (Copy) สไลดท่ี์ไม่ถูกต้อง ในการใชโ้ปรแกรม Microsoft  
PowerPoint 
  1. ท่ีแทบ็ Slide →  คลิกเมาส์ขวาสไลดท่ี์ตอ้งการ →  เลือกค าส่ัง  Copy 
  2. ท่ีแทบ็ Outline →  คลิกเมาส์ขวาสไลดท่ี์ตอ้งการ →  เลือกค าส่ัง  Copy 
  3. ท่ีแทบ็ Slide Sorter →  คลิกเมาส์ขวาสไลดท่ี์ตอ้งการ →  เลือกค าส่ัง  Copy 
  4. คลิกเมาส์ซา้ยท่ีค าส่ัง Insert →  คลิกเมาส์ซา้ยท่ีค าส่ัง  Copy 
5. Normal View (มุมมองปกติ) แบ่งพ้ืนท่ีท างานออกเป็นก่ีส่วน 
  1. 1 ส่วน  2. 2 ส่วน 
  3. 3 ส่วน  4. 4 ส่วน 
6. ขอ้ใดกล่าวถูกตอ้งเก่ียวกบัมุมมอง Slide Sorter View 
  1. จะแสดงภาพตวัอยา่งขนาดเลก็ของสไลด ์
  2. จะแสดงภาพตวัอยา่งของสไลดก่์อนท่ีจะท าการพิมพ ์
  3. จะแสดงภาพตวัอยา่งขนาดใหญข่องสไลด ์  
 4. ไม่มีขอ้ใดถูก 
7. ขณะท่ีมีการแสดงสไลดเ์ตม็หนา้จออยู ่หากตอ้งการเปล่ียนฉายสไลดแ์ผน่ถดัไปตอ้งท าอยา่งไร 
  1. คลิกเมาส์ 2.กดคีย ์Enter 
  3. คลิกบนพ้ืนท่ีวา่ง 4.ขอ้ 1. และ 2. ถูก 
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8. การลบแผน่สไลดส์ามารถท าไดโ้ดยวิธีใด 
  1. คลิกขวาบนแผน่สไลด ์แลว้เลือกค าส่ัง Delete Slide 
  2. กดคีย ์Delete 
  3. ใชปุ้่ ม Cut  4.ถูกทุกขอ้  
9. Slide Master คืออะไร 
  1. ตน้แบบท่ีใชใ้นการสร้างพ้ืนหลงั   
  2.    ตน้แบบท่ีใชใ้นการออกแบบงานน าเสนอ 
  3. ตน้แบบท่ีใชใ้นการสร้างสไลด์ 4. ตน้แบบท่ีใชใ้นการแทรกรูปภาพ 
10. หากตอ้งการเปล่ียนขนาดสไลดจ์ะตอ้งด าเนินการตามขอ้ใดเป็นขั้นตอนแรก 
  1. เลือกขนาดของพ้ืนท่ีพิมพ ์ 2. Design  Page Setup 
  3. ใชปุ้่ ม Minimize 4. View  Slide Show 
11. ขอ้ใดเป็นวิธีการคดัลอกสไลด ์ในโปรแกรม Microsoft PowerPoint 
  1. คลิกแทบ็ Slide  Ctrl + C  Ctrl + V 
  2. คลิกแทบ็ Slide  คลิกเมาส์ขวาท่ีสไลดท่ี์ตอ้งการคดัลอก  Duplicate Slide 
  3. คลิกแทบ็ Design  Page Setup  New Slide 
  4. ขอ้ 1. และ 2. ถูก  
12. การส่ังฉายสไลดส์ามารถท าไดโ้ดยวิธีใด 
  1. ใชค้  าส่ัง Slice Show  Start Slide Show 2. คลิกปุ่ ม Slide Show 
  3. กด F5  4. ถูกทุกขอ้  
13. ขอ้ใดเป็นวิธีเพ่ิมสไลด ์(Slide) หนา้ใหม่ในโปรแกรม Microsoft PowerPoint 
  1. คลิกแทบ็ Home  New Slide 2. กดปุ่ ม Ctrl + M 
  3. คลิกแทบ็ Design  New Slide 4. ขอ้ 1. และ 2. ถูก  
14. ขอ้ใดเป็นการเปล่ียนพ้ืนหลงัสไลด ์ในโปรแกรม Microsoft PowerPoint 
  1. คลิกขวาบนพ้ืนสไลดแ์ลว้เลือก Format Background  เลือก Fill  
  2. คลิกแทบ็ Design  เลือก ลกัษณะพ้ืนหลงั (Background Styles)  แลว้เลือกสีท่ี 
ตอ้งการ 
  3. คลิกแทบ็ Design  เลือก ลกัษณะพ้ืนหลงั (Background Styles)  แลว้เลือก  
จดัรูปแบบพ้ืนหลงั (Format Background) 
  4. ถูกทุกขอ้ 
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15. ขอ้ใดกล่าวผิด เก่ียวกบัการพิมพเ์อกสารเป็น PowerPoint 
  1. สามารถส่ังพิมพเ์อกสารโดยไม่ตอ้งพิมพพ้ื์นหลงั 
  2. สามารถส่ังพิมพโ์ดยเลือกพิมพ ์ได ้2 แบบ คือ แบบสี และแบบขาวด า 
  3. สามารถจดัพิมพเ์คา้ร่างลงบนกระดาษได ้
  4. สามารถก าหนดไดว้า่ในกระดาษหน่ึงแผน่จะประกอบไปดว้ยสไลดก่ี์แผ่น  
16. ขอ้ไม่ใช่ขั้นตอนของการใส่ลูกเล่นใหก้บัขอ้ความหรือออบเจค็  
  1. คลิกบนออบเจค็ แลว้เลือก Add Animation 2. คลิกบนออบเจค็ แลว้เลือก More Effect 
  3. คลิกบนออบเจค็ แลว้เลือก Animation 4. คลิกบนออบเจค็ แลว้เลือก Background 
17. ถา้ตอ้งการลบเอฟเฟคตใ์ดออกตอ้งท าอยา่งไร 
  1. คลิกเลือกเลขล าดบัของเอฟเฟคตท่ี์จะยกเลิก แลว้กดปุ่ ม Delete 
  2. คลิกบนออบเจค็ท่ีจะยกเลิก แลว้กดปุ่ ม Delete 
  3. คลิกเอฟเฟคต ์แลว้กดปุ่ ม End 
  4. ถูกทุกขอ้  
18. การใส่ลูกเล่นขณะเปล่ียนแผน่สไลด ์สามารถท าโดยขั้นตอนใด 
  1. คลิก View  Slide Sorter View  Transitions  เลือก Slide ท่ีตอ้งการ  เลือก  Effect 
  2. คลิก Transition  เลือก Slide ท่ีตอ้งการ  เลือก Effect 
  3. คลิก Animation  เลือก Slide ท่ีตอ้งการ  เลือก Effect 
  4. ขอ้ 1. และ 2. ถูก 
19. ขอ้ใดกล่าวถูกตอ้ง เก่ียวกบัการเล่ือนสไลดข์ณะท าการน าเสนอ 
  1. เม่ือคลิกเมาส์ดา้นซา้ย หรือ ดา้นขวา 1 คร้ัง สไลดจ์ะเปล่ียนไป  1  ล าดบั 
  2. กด  <N>  และ  <P>  ในการเล่ือนสไลดไ์ปขา้งหนา้และยอ้นกลบั 
  3. การยกเลิกการน าเสนอใหก้ดปุ่ ม Shift  +  < - > 
       4. การกระโดดไปยงัแผน่สไลดท่ี์ตอ้งการใหก้ดตวัเลขของหนา้สไลดท่ี์ตอ้งการ แลว้กด <Space bar>  
20. ขอ้ใดกล่าวผิดเก่ียวกบัการใส่ไฟลเ์สียงในสไลด ์
  1. เร่ิมตน้คลิกเมนู Insert  Audio 
  2. ไฟลเ์สียงท่ีใส่นิยม คือ ไฟล ์MP3 และ WMA เน่ืองจากเป็นไฟลข์นาดเลก็แต่ใหคุ้ณภาพ 
เสียงใกลเ้คียงกบัตน้ฉบบั 
  3. ในโปรแกรมน าเสนอสามารถใส่ไฟลเ์สียงท่ีเป็นเพลง, ภาพยนตร์และเสียง แต่ไม่สามารถ 
ใชเ้สียงท่ีอดัประกอบสไลดไ์ด ้  
  4. สามารถปรับระดบัเสียงและซ่อนไอคอนล าโพงได ้ 
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21. หากเราตอ้งการส่ังพิมพเ์อกสารประกอบการบรรยายจากสไลดจ์ะตอ้งด าเนินการตามขอ้ใดเป็นอนัดบัแรก 
 1. เลือกค าส่ัง File 2. เลือกค าส่ัง Insert 
 3. เลือกค าส่ัง Tools 
 4. ถูกทุกขอ้  
22. ขอ้ใดเป็นการใชไ้ดอะแกรมท่ีเหมาะสม 
  1. วีณา ตอ้งการไดอะแกรมท่ีใชแ้สดงพ้ืนท่ีท่ีมีความสัมพนัธ์กนั จึงเลือกใช ้Venn Diagram 
  2. วีระ ตอ้งการท าไดอะแกรมท่ีใชแ้สดงล าดบัสายการบงัคบับญัชา จึงเลือกใช ้Venn Diagram 
  3. ประมาณ ตอ้งการไดอะแกรมท่ีใชแ้สดงขั้นตอนการท างาน จึงเลือกใช ้Venn Diagram 
  4. รัศมี ตอ้งการไดอะแกรมท่ีใชแ้สดงความสัมพนัธ์ของขอ้มูลกบัแกนหลกั จึงเลือกใช ้Venn Diagram 
23. ขอ้ใดคือช่ือไฟลท่ี์ไดจ้ากการบนัทึกโปรแกรมน าเสนอขอ้มูล 
   1. power.exe 2. power.pdf 
   3. power.pptx 4. power.ptt 
24. การใส่เสียงใหก้บั Presentation (PowerPoint) ตอ้งเขา้ไปท่ีค าส่ังใด 
   1. Setting Sound card option 2. Loop Until Next Sound 
   3. Placing the microphone 4. Editing Sound  
25. การวาดภาพทึบสีหลายภาซอ้นกนัหากใชค้  าส่ัง Sent to Back กบัภาพท่ีอยูล่  าดบับนสุดจะเกิดผลลพัธ์อยา่งไร 
  1. ภาท่ีอยูล่  าดบับนสุดจะเปล่ียนไปอยูล่  าดบัท่ี 2 
  2. ภาท่ีอยูล่  าดบับนสุดจะหายไป 
  3. ภาท่ีอยูล่  าดบับนสุดจะไปอยูล่  าดบัสุดทา้ย 
  4. ภาท่ีอยูล่  าดบับนสุดเปล่ียนไปอยูบ่นสไลดอ่ื์น 
  

เฉลย MS – PowerPoint 
ขอ้ 1. 1 ขอ้ 6. 1 ขอ้ 11. 4 ขอ้ 16. 4 ขอ้ 21. 1 
ขอ้ 2. 1 ขอ้ 7. 4 ขอ้ 12. 4 ขอ้ 17. 1 ขอ้ 22. 1 
ขอ้ 3. 1 ขอ้ 8. 1 ขอ้ 13. 4 ขอ้ 18. 4 ขอ้ 23. 3 
ขอ้ 4. 4 ขอ้ 9. 3 ขอ้ 14. 4 ขอ้ 19. 2 ขอ้ 24. 2 
ขอ้ 5. 3 ขอ้ 10. 2 ขอ้ 15. 2 ขอ้ 20. 3 ขอ้ 25. 3 

 
-------------------------------- 
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 แนวข้อสอบพ.ร.บ.ระเบียบบริหารราชการแผ่นดิน พ.ศ. 2534 
และที่แก้ไขเพิม่เติมถึงฉบับท่ี 8. พ.ศ. 2553 

1. พระราชบญัญติัระเบียบบริหารราชการแผน่ดิน พ.ศ. ๒๕๓๔แกไ้ขเพ่ิมเติมถึงปัจจุบนั ใหไ้วเ้ม่ือใด 
 ก. ใหไ้ว ้ณ วนัท่ี ๒๑ สิงหาคม พ.ศ. ๒๕๓๔  ข. ใหไ้ว ้ณ วนัท่ี ๒๑ สิงหาคม พ.ศ. ๒๕๓๕ 
 ค. ใหไ้ว ้ณ วนัท่ี ๑ สิงหาคม พ.ศ. ๒๕๓๔  ง. ใหไ้ว ้ณ วนัท่ี ๒๑ สิงหาคม พ.ศ. ๒๕๓๕ 
ตอบ ข้อ ก.  ค าอธิบาย ภูมิพลอดุลยเดช ป.ร.ใหไ้ว ้ณ วนัท่ี ๒๑ สิงหาคม พ.ศ. ๒๕๓๔เป็นปีท่ี ๔๖ ในรัชกาล
ปัจจุบนั 
2. พระบาทสมเด็จพระปรมินทรมหาภูมิพลอดุลยเดช มีพระบรมราชโองการโปรดเกลา้ฯ ใหป้ระกาศวา่โดยท่ี
เป็นการสมควรปรับปรุงกฎหมายวา่ดว้ยระเบียบบริหารราชการแผน่ดินโดยค าแนะน าและยนิยอมของใคร 
 ก. คณะผูป้กครองแผน่ดินสูงสุด   ข. คณะตุลาการศาลรัฐธรรมนูญ 
 ค. สภานิติบญัญติั     ง. คณะนายทหารปฏิวติัสูงสุด 
ตอบ ข้อ ค.  ค าอธิบาย พระบาทสมเด็จพระปรมินทรมหาภูมิพลอดุลยเดช มีพระบรมราชโองการโปรดเกลา้ฯ ให้
ประกาศวา่โดยท่ีเป็นการสมควรปรับปรุงกฎหมายวา่ดว้ยระเบียบบริหารราชการแผน่ดิน 
  จึงทรงพระกรุณาโปรดเกลา้ฯ ใหต้ราพระราชบญัญติัข้ึนไวโ้ดยค าแนะน าและยนิยอมของสภานิติบญัญติั
แห่งชาติ 
3. พระราชบญัญติัน้ีใหใ้ชบ้งัคบัตั้งแต่เม่ือใด 
 ก. พระราชบญัญติัน้ีใหใ้ชบ้งัคบัตั้งแต่วนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 ข. พระราชบญัญติัน้ีใหใ้ชบ้งัคบัตั้งแต่วนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 ค. พระราชบญัญติัน้ีใหใ้ชบ้งัคบัหลงั ๓๐วนั นบัตั้งแต่วนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 ง. พระราชบญัญติัน้ีใหใ้ชบ้งัคบัหลงั ๓๐วนั นบัตั้งแต่วนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
ตอบ ข้อ ก. 
4. ขอ้ใดกล่าวถึงการจดัระเบียบบริหารราชการแผน่ดินไดถู้กตอ้ง 
 ก. ส่วนกลาง ส่วนภูมิภาค  ส่วนทอ้งถ่ิน 
 ข. ส่วนรัฐมนตรี  ส่วนผูว้า่ราชการจงัหวดั  ส่วนนายอ าเภอ ส่วนทอ้งถ่ิน 
 ค. กรุงเทพ   ภาค   จงัหวดั  อ าเภอ   ง. กรุงเทพ   เมือง   ประเทศราชปัตตานี 
ตอบ ก. ค าอธิบาย มาตรา ๔ ใหจ้ดัระเบียบบริหารราชการแผน่ดิน ดงัน้ี 
 (๑) ระเบียบบริหารราชการส่วนกลาง (๒) ระเบียบบริหารราชการส่วนภูมิภาค (๓) ระเบียบบริหารราชการ
ส่วนทอ้งถ่ิน 
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5. ขอ้ใดกล่าวถึงการกระท านั้น ตอ้งก าหนดต าแหน่งและอตัราเงินเดือนโดยค านึงถึงคุณภาพและปริมาณงาน
ของส่วนราชการนั้นๆ   
 ก. การปกครองประเทศ    ข. การแบ่งราชการออกเป็นส่วนต่างๆ  
 ค. การก าหนดต าแหน่งส่วนราชการต่างๆ   ง. ถูกทุกขอ้ 
ตอบ ข้อ ข.ค าอธิบาย มาตรา ๕ การแบ่งราชการออกเป็นส่วนต่าง ๆ ตามท่ีบญัญติัไวใ้นพระราชบญัญติัน้ี ให้
ก าหนดต าแหน่งและอตัราเงินเดือนโดยค านึงถึงคุณภาพและปริมาณงานของส่วนราชการนั้น ๆ ไวด้ว้ย 
การบรรจุและการแต่งตั้งบุคคลใหด้ ารงต าแหน่งหนา้ท่ีราชการต่าง ๆ ใหเ้ป็นไปตามกฎหมาย 
6. ใครเป็นผูรั้กษาการตามพระราชบญัญติัน้ี 
 ก. ประธาน คสช.     ข. ประธานรัฐสภา 
 ค. นายกรัฐมนตรี     ง. รองนายกรัฐมนตรีฝ่ายความมัน่คง 
ตอบ ข้อ  ค. ค าอธิบาย มาตรา ๖ ใหน้ายกรัฐมนตรีรักษาการตามพระราชบญัญติัน้ี 
7. การจดัตั้ง การรวม หรือการโอนส่วนราชการ ใหต้ราเป็นกฎหมายใด 
 ก. พระราชบญัญติั  ข. พระราชกฤษฎีกา ค. ประกาศกระทรวง ง. กฎกระทรวง 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๘ การจดัตั้ง การรวม หรือการโอนส่วนราชการตามมาตรา ๗ ใหต้ราเป็น
พระราชบญัญติั 
การจดัตั้งทบวงโดยใหสั้งกดัส านกันายกรัฐมนตรีหรือกระทรวง ใหร้ะบกุารสังกดัไวใ้นพระราชบญัญติัดว้ย 
การจดัตั้งกรมหรือส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนและมีฐานะเป็นกรม ซ่ึงไม่สังกดัส านกันายกรัฐมนตรี กระทรวง 
หรือทบวง ใหร้ะบุการไม่สังกดัไวใ้นพระราชบญัญติัดว้ย 
8. การจดัตั้งส่วนราชการข้ึนใหม่หรือไม่ ถา้ไม่มีการก าหนดต าแหน่งหรืออตัราของขา้ราชการหรือลูกจา้ง
เพ่ิมข้ึนใหต้ราเป็นกฎหมายใด 
 ก. พระราชบญัญติั  ข. กฎกระทรวง  ค. ประกาศส่วนราชการ ง. พระราชกฤษฎีกา 
ตอบ ข้อ ง. ค าอธิบาย มาตรา ๘ ทวิ การรวมหรือการโอนส่วนราชการตามมาตรา ๗ ไม่วา่จะมีผลเป็นการจดัตั้งส่วน
ราชการข้ึนใหม่หรือไม่ ถา้ไม่มีการก าหนดต าแหน่งหรืออตัราของขา้ราชการหรือลูกจา้งเพ่ิมข้ึนใหต้ราเป็นพระราช
กฤษฎีกาพระราชกฤษฎีกาตามวรรคหน่ึง ให้ระบุอ านาจหนา้ท่ีของส่วนราชการ การโอนอ านาจหนา้ท่ีตาม
บทบญัญติัแห่งกฎหมาย ซ่ึงส่วนราชการหรือเจา้พนกังานท่ีมีอยูเ่ดิม การโอนขา้ราชการและลูกจา้ง งบประมาณ
รายจ่าย รวมทั้งทรัพยสิ์นและหน้ีสินเอาไวด้ว้ย แลว้แต่กรณี 
9. การเปล่ียนช่ือส่วนราชการใหต้ราเป็นกฎหมายใด 
 ก. พระราชกฤษฎีกา    ข. พระราชบญัญติั 
 ค. กฎกระทรวง     ง. ประกาศส านกันายกรัฐมนตรี 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๘ ตรี การเปล่ียนช่ือส่วนราชการตามมาตรา ๗ ใหต้ราเป็นพระราชกฤษฎีกา และใน
กรณีท่ีช่ือต าแหน่งของขา้ราชการในส่วนราชการนั้นเปล่ียนไปใหร้ะบุการเปล่ียนช่ือไวใ้นพระราชกฤษฎีกาดว้ย
บทบญัญติัแห่งกฎหมาย กฎ ระเบียบ ขอ้บงัคบั เทศบญัญติัหรือขอ้บญัญติัทอ้งถ่ินอ่ืน ประกาศ หรือค าส่ังใดท่ีอา้งถึง
ส่วนราชการหรือต าแหน่งของขา้ราชการท่ีไดถู้กเปล่ียนช่ือตามวรรคหน่ึง ใหถื้อวา่บทบญัญติัแห่งกฎหมาย กฎ 
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ระเบียบ ขอ้บงัคบั เทศบญัญติัหรือขอ้บญัญติัทอ้งถ่ินอ่ืน ประกาศหรือค าส่ังนั้นอา้งถึงส่วนราชการหรือต าแหน่งของ
ขา้ราชการท่ีไดเ้ปล่ียนช่ือนั้น 
10. การแบ่งส่วนราชการภายในส านกังานรัฐมนตรี กรม หรือส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนและมีฐานะเป็นกรม 
ใหอ้อกเป็นกฎหมายใด 
 ก. ประกาศกระทรวง ข. กฎกระทรวง  ค. พระราชกฤษฎีกา ง. ถูกทุกขอ้ 
ตอบ ข้อ ข. ค าอธิบาย มาตรา ๘ ฉ การแบ่งส่วนราชการภายในส านกังานรัฐมนตรี กรม หรือส่วนราชการท่ีเรียกช่ือ
อยา่งอ่ืนและมีฐานะเป็นกรม ใหอ้อกเป็นกฎกระทรวงและใหร้ะบุอ านาจหนา้ท่ีของแต่ละส่วนราชการไวใ้น
กฎกระทรวงดว้ย 
 ใหรั้ฐมนตรีเจา้สังกดัของส่วนราชการตามวรรคหน่ึงเป็นผูอ้อกกฎกระทรวงแบ่งส่วนราชการดงักล่าว 
กฎกระทรวงนั้นเม่ือไดป้ระกาศในราชกิจจานุเบกษาแลว้ใหใ้ชบ้งัคบัได ้
11. ใครเป็นผูอ้อกกฎกระทรวงแบ่งส่วนราชการ 
 ก. ปลดักระทรวง     ข. นายกรัฐมนตรี 
 ค. รัฐมนตรีเจา้สังกดั    ง. รองปลดักระทรวงหวัหนา้กลุ่มภารกิจ 
ตอบ ข้อ ค.ค าอธิบาย มาตรา ๘ สัตต ใหส้ านกังานคณะกรรมการขา้ราชการพลเรือนและส านกังบประมาณร่วมกนั
เสนอความเห็นต่อคณะรัฐมนตรีในการแบ่งส่วนราชการภายในและในการก าหนดอ านาจหนา้ท่ีของแต่ละส่วน
ราชการตามมาตรา ๘ ฉ ในการเสนอความเห็นดงักล่าวใหส้ านกังานคณะกรรมการขา้ราชการพลเรือนจดัอตัราก าลงั 
และส านกังบประมาณจดัสรรเงินงบประมาณใหส้อดคลอ้งเสนอไปในคราวเดียวกนั 
 มาตรา ๘ อฏัฐ การแบง่ส่วนราชการภายในมหาวิทยาลยัหรือสถาบนัในทบวงมหาวิทยาลยัใหเ้ป็นไปตาม
กฎหมายวา่ดว้ยมหาวิทยาลยัหรือสถาบนันั้น 
12. ส านกันายกรัฐมนตรีใครเป็นผูบ้งัคบับญัชา 
 ก. ปลดัส านกันายกรัฐมนตรี   ข. นายกรัฐมนตรี 
 ค. ผบ.ทร.      ง. หวัหนา้ส านกันายกรัฐมนตรี 
ตอบ ข้อ ข. ค าอธิบาย มาตรา ๑๐ ส านกันายกรัฐมนตรีมีอ านาจหนา้ท่ีตามท่ีก าหนดไวใ้นกฎหมายวา่ดว้ยการ
ปรับปรุงกระทรวงทบวง กรมส านกันายกรัฐมนตรีมีนายกรัฐมนตรีเป็นผูบ้งัคบับญัชาขา้ราชการและรับผิดชอบใน
การก าหนดนโยบาย เป้าหมาย และผลสัมฤทธ์ิของงานในส านกันายกรัฐมนตรีใหส้อดคลอ้งกบันโยบายท่ี
คณะรัฐมนตรีแถลงไวต่้อรัฐสภาหรือท่ีคณะรัฐมนตรีก าหนดหรืออนุมติั โดยจะใหมี้รองนายกรัฐมนตรีและ
รัฐมนตรีประจ าส านกันายกรัฐมนตรีเป็นผูช่้วยส่ังและปฏิบติัราชการก็ได ้
 
 
 
 
 
 

ตัว
อย
่าง



คู่มือสอบพนกังานวิเคราะหน์โยบายและแผน ที่ท าการปกครองจังหวดันครศรีธรรมราช  24 

------------------------------------------------------------ 

13. ขอ้ใดกล่าวถูกตอ้งท่ีสุดเก่ียวกบัส านกัเลขาธิการนายกรัฐมนตรี 
 ก. เลขาธิการนายกรัฐมนตรีเป็นผูบ้งัคบับญัชาขา้ราชการ 
 ข. เลขาธิการนายกรัฐมนตรีและรองเลขาธิการนายกรัฐมนตรีฝ่ายการเมือง เป็นขา้ราชการพลเรือนสามญั 
 ค. รองเลขาธิการนายกรัฐมนตรีฝ่ายบริหาร เป็นขา้ราชการฝ่ายการเมือง 
 ง. ก. และ ค. ถูกตอ้ง 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๑๓ ส านกัเลขาธิการนายกรัฐมนตรี มีอ านาจหนา้ท่ีเก่ียวกบัราชการทางการเมือง มี
เลขาธิการนายกรัฐมนตรีเป็นผูบ้งัคบับญัชาขา้ราชการ และรับผิดชอบในการปฏิบติัราชการข้ึนตรงต่อ
นายกรัฐมนตรี และใหมี้รองเลขาธิการนายกรัฐมนตรีฝ่ายการเมืองและรองเลขาธิการนายกรัฐมนตรีฝ่ายบริหาร เป็น
ผูช่้วยส่ังและปฏิบติัราชการและจะใหมี้ผูช่้วยเลขาธิการนายกรัฐมนตรี เป็นผูช่้วยส่ังและปฏิบติัราชการดว้ยก็ไดใ้ห้
เลขาธิการนายกรัฐมนตรีและรองเลขาธิการนายกรัฐมนตรีฝ่ายการเมือง เป็นขา้ราชการการเมือง และใหร้อง
เลขาธิการนายกรัฐมนตรีฝ่ายบริหาร และผูช่้วยเลขาธิการนายกรัฐมนตรี เป็นขา้ราชการพลเรือนสามญั 
14. ขอ้ใดต่อไปน้ี คือการจดัระเบียบราชการของกระทรวง 
 ก. ส านกังานรัฐมนตรี  ส านกังานปลดักระทรวง  กรม 
 ข. ส านกังานเลขานุการรัฐมนตรี  ส านกังานปลดักระทรวง  กรม 
 ค. ส านกังานรัฐมนตรี  ส านกังานกระทรวง   กรม 
 ง. ส านกังานรัฐมนตรี  ส านกังานปลดักระทรวง  ส านกังานเลขานุการกรม 
ตอบ ข้อ ก. ค าอธิบาย การจดัระเบียบราชการในกระทรวงหรือทบวง 
 มาตรา ๑๘ ใหจ้ดัระเบียบราชการของกระทรวง ดงัน้ี 
 (๑) ส านกังานรัฐมนตรี (๒) ส านกังานปลดักระทรวง (๓) กรม หรือส่วนราชการท่ีเรียกช่ืออยา่งอ่ืน เวน้แต่
บางกระทรวงเห็นวา่ไม่มีความจ าเป็นจะไม่แยกส่วนราชการตั้งข้ึนเป็นกรมก็ได ้
 ใหส่้วนราชการตาม (๒) และส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนตาม (๓) มีฐานะเป็นกรม 
15. กระทรวงใดมีความจ าเป็นจะตอ้งมีส่วนราชการเพ่ือท าหนา้ท่ีจดัท านโยบายและแผน ก ากบั เร่งรัด และ
ติดตามนโยบายและแผนการปฏิบติัราชการของกระทรวง จะจดัระเบียบบริหารราชการโดยอนุมติัคณะรัฐมนตรี
เพ่ือใหมี้ส านกันโยบายและแผนเป็นส่วนราชการภายใน ข้ึนตรงต่อใคร 
 ก. รัฐมนตรี     ข. ปลดักระทรวง 
 ค. รองปลดักระทรวงหัวหนา้กลุ่มภารกิจ  ง. นายกรัฐมนตรี 
ตอบ ข้อ ก.ค าอธิบาย มาตรา ๑๘ ... กระทรวงใดมีความจ าเป็นจะตอ้งมีส่วนราชการเพ่ือท าหนา้ท่ีจดัท านโยบายและ
แผน ก ากบั เร่งรัด และติดตามนโยบายและแผนการปฏิบติัราชการของกระทรวง จะจดัระเบียบบริหารราชการโดย
อนุมติัคณะรัฐมนตรีเพื่อใหมี้ส านกันโยบายและแผนเป็นส่วนราชการภายใน ข้ึนตรงต่อรัฐมนตรีวา่การกระทรวงก็
ได ้
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16. หน่วยงานใดมีอ านาจหนา้ท่ีเก่ียวกบัราชการประจ าทัว่ไปของกระทรวง และราชการท่ีคณะรัฐมนตรีมิได้
ก าหนดใหเ้ป็นหนา้ท่ีของกรมใดกรมหน่ึงในสังกดักระทรวงโดยเฉพาะ รวมทั้งก ากบัและเร่งรัดการปฏิบติัราชการ
ของส่วนราชการในกระทรวงใหเ้ป็นไปตามนโยบายแนวทาง และแผนการปฏิบติัราชการของกระทรวง 
 ก. ส านกังานรัฐมนตรี    ข. ส านกังานปลดักระทรวง 
 ค. ศูนยบ์ริการร่วมกระทรวง   ง. ส านกันโยบายและแผนกระทรวง 
ตอบ ข้อ ข. ค าอธิบาย มาตรา ๒๓ ส านกังานปลดักระทรวงมีอ านาจหนา้ท่ีเก่ียวกบัราชการประจ าทัว่ไปของ
กระทรวง และราชการท่ีคณะรัฐมนตรีมิไดก้ าหนดใหเ้ป็นหนา้ท่ีของกรมใดกรมหน่ึงในสังกดักระทรวงโดยเฉพาะ 
รวมทั้งก ากบัและเร่งรัดการปฏิบติัราชการของส่วนราชการในกระทรวงใหเ้ป็นไปตามนโยบายแนวทาง และ
แผนการปฏิบติัราชการของกระทรวง 
 ในกรณีท่ีกระทรวงมีทบวงอยูใ่นสังกดัและยงัไม่สมควรจดัตั้งส านกังานปลดัทบวงตามมาตรา ๒๕ วรรค
สาม จะใหส้ านกังานปลดักระทรวงท าหนา้ท่ีส านกังานปลดัทบวงดว้ยก็ได ้
17. ราชการส่วนใดซ่ึงโดยสภาพและปริมาณของงานไม่เหมาะสมท่ีจะจดัตั้งเป็นกระทรวงหรือทบวงซ่ึงมีฐานะ
เทียบเท่ากระทรวง ใหจ้ดัตั้งเป็น 
 ก. ทบวงสังกดัส านกันายกรัฐมนตรีหรือกระทรวง ข. ศูนยร์าชการพิเศษ 
 ค. กรมพิเศษ     ง. ทบวง 
ตอบ ข้อ ก. ค าอธิบาย หมวด ๓   การจดัระเบียบราชการในทบวงซ่ึงสังกดัส านกันายกรัฐมนตรีหรือกระทรวง 
มาตรา ๒๕ ราชการส่วนใดซ่ึงโดยสภาพและปริมาณของงานไม่เหมาะสมท่ีจะจดัตั้งเป็นกระทรวงหรือทบวงซ่ึงมี
ฐานะเทียบเท่ากระทรวง จะจดัตั้งเป็นทบวงสังกดัส านกันายกรัฐมนตรีหรือกระทรวง เพ่ือใหมี้รัฐมนตรีวา่การทบวง
เป็นผูบ้งัคบับญัชาขา้ราชการ และรับผิดชอบในการปฏิบติัราชการของทบวงก็ได ้และใหจ้ดัระเบียบราชการใน
ทบวงดงัน้ี 
 (๑) ส านกังานรัฐมนตรี (๒) ส านกังานปลดัทบวง (๓) กรม หรือส่วนราชการท่ีเรียกช่ืออยา่งอ่ืน เวน้แต่บาง
ทบวงซ่ึงเห็นวา่ไม่มีความจ าเป็นจะไม่แยกส่วนราชการตั้งข้ึนเป็นกรมก็ได ้
 ใหส่้วนราชการตาม (๒) และส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนตาม (๓) มีฐานะเป็นกรม 
18. ในกรณีท่ีส านกันายกรัฐมนตรีหรือกระทรวงมีทบวงอยูใ่นสังกดั และปริมาณ และคุณภาพของราชการใน
ทบวงยงัไม่สมควรจดัตั้งส านกังานปลดัทบวง จะใหห้น่วยงานใดท าหนา้ท่ีส านกังานปลดัทบวงดว้ยก็ได ้
 ก.ส านกังานรัฐมนตรี    ข. ส านกังานปลดัส านกันายกรัฐมนตรี 
 ค. ส านกังานรองปลดักระทรวงหวัหนา้กลุ่มภารกิจ  ง. กรมท่ีไดรั้บมอบหมายจากนายกรัฐมนตรี 
ตอบ ข. ค าอธิบาย มาตรา ๒๕ ... ในกรณีท่ีส านกันายกรัฐมนตรีหรือกระทรวงมีทบวงอยูใ่นสังกดั และปริมาณ และ 
คุณภาพของราชการในทบวงยงัไม่สมควรจดัตั้งส านกังานปลดัทบวง จะใหส้ านกังานปลดัส านกันายกรัฐมนตรีหรือ 
ส านกังานปลดักระทรวงท าหนา้ท่ีส านกังานปลดัทบวงดว้ยก็ได ้ 
 
 
 

ตัว
อย
่าง



คู่มือสอบพนกังานวิเคราะหน์โยบายและแผน ที่ท าการปกครองจังหวดันครศรีธรรมราช  26 

------------------------------------------------------------ 

19. ขอ้ใดคือการแบ่งส่วนราชการภายในกรม 
 ก. ส านกังานเลขานุการกรม  กอง   ข.  ส านกังานเลขานุการกรม  กองฝ่าย 
 ค. ส านกังานเลขานุการกรม  ส านกั  กอง  ง. กอง ฝ่าย ส่วน  
ตอบ ข้อ ก.ค าอธิบาย หมวด ๔ การจดัระเบียบราชการในกรม 
มาตรา ๓๑ กรมซ่ึงสังกดัหรือไม่สังกดัส านกันายกรัฐมนตรี กระทรวง หรือทบวง อาจแบ่งส่วนราชการดงัน้ี 
 (๑) ส านกังานเลขานุการกรม 
 (๒) กองหรือส่วนราชการท่ีมีฐานะเทียบกอง เวน้แต่บางกรมเห็นวา่ไม่มีความจ าเป็นจะไม่แยกส่วนราชการ
ตั้งข้ึนเป็นกองก็ไดก้รมใดมีความจ าเป็น จะแบ่งส่วนราชการโดยใหมี้ส่วนราชการอ่ืนนอกจาก (๑) หรือ (๒) ก็ได ้
20. ส่วนราชการใดมีอ านาจหนา้ท่ีเก่ียวกบัราชการทัว่ไปของกรม และราชการท่ีมิไดแ้ยกใหเ้ป็นหนา้ท่ีของกอง
หรือส่วนราชการใดโดยเฉพาะ 
 ก. ส านกังานเลขานุการกรม  ข. กอง  ค. ส่วนตรวจสอบภายใน  ง. ก และ ค. ถูกตอ้ง 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๓๓ ส านกังานเลขานุการกรมมีอ านาจหนา้ท่ีเก่ียวกบัราชการทัว่ไปของกรม และ
ราชการท่ีมิไดแ้ยกใหเ้ป็นหนา้ท่ีของกองหรือส่วนราชการใดโดยเฉพาะมีเลขานุการกรมเป็นผูบ้งัคบับญัชา
ขา้ราชการ และรับผิดชอบในการปฏิบติัราชการของส านกังานเลขานุการกรมส่วนราชการตามมาตรา ๓๑ วรรค
หน่ึง (๒) และส่วนราชการตามมาตรา ๓๑ วรรคสอง ใหมี้อ านาจหนา้ท่ีตามท่ีไดก้ าหนดไวใ้หเ้ป็นหนา้ท่ีของส่วน
ราชการนั้น ๆ โดยใหมี้ผูอ้  านวยการกอง หวัหนา้กอง หรือหวัหนา้ส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนท่ีเทียบเท่ากบั
ผูอ้  านวยการกอง หรือหวัหนา้กอง หรือหวัหนา้ส่วนราชการตามมาตรา ๓๑ วรรคสอง เป็นผูบ้งัคบับญัชาขา้ราชการ 
และรับผิดชอบในการปฏิบติัราชการ  
21. กระทรวง ทบวง กรมใดมีเหตุพิเศษ จะตราเป็นกฎหมายใดแบ่งทอ้งท่ีออกเป็นเขตเพ่ือใหมี้หวัหนา้ส่วน
ราชการประจ าเขตแลว้แต่จะเรียกช่ือเพ่ือปฏิบติังานทางวิชาการก็ได ้
 ก. กฎกระทรวง ข. พระราชกฤษฎีกา ค. พระราชบญัญติั ง. ประกาศกระทรวง 
ตอบ ข้อ ข. ค าอธิบาย มาตรา ๓๔ กระทรวง ทบวง กรมใดมีเหตุพิเศษ จะตราพระราชกฤษฎีกาแบ่งทอ้งท่ีออกเป็น
เขตเพ่ือใหมี้หวัหนา้ส่วนราชการประจ าเขตแลว้แต่จะเรียกช่ือเพ่ือปฏิบติังานทางวิชาการก็ไดห้วัหนา้ส่วนราชการ
ประจ าเขตมีอ านาจหนา้ท่ีเป็นผูรั้บนโยบายและค าส่ังจากกระทรวง ทบวง กรม มาปฏิบติังานทางวิชาการ และเป็น
ผูบ้งัคบับญัชาขา้ราชการประจ าส านกังานเขตซ่ึงสังกดักระทรวง ทบวง กรมนั้นความในมาตราน้ีไม่ใชบ้งัคบัแก่การ
แบ่งเขตและการปกครองบงัคบับญัชาของต ารวจและอยัการซ่ึงไดก้ าหนดโดยพระราชกฤษฎีกา 
22. ในกรณีท่ีไม่มีผูด้  ารงต าแหน่งรองปลดักระทรวง หรือมีแต่ไม่อาจปฏิบติัราชการได ้ปลดักระทรวงจะแต่งตั้ง
ขา้ราชการในกระทรวงซ่ึงด ารงต าแหน่งไม่ต ่ากวา่ต าแหน่งใดเป็นผูรั้กษาราชการแทน 
 ก. ผูอ้  านวยการกอง ข. ผูอ้  านวยการส านกั ค. ผูต้รวจราชการ ง. อธิบดี 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๔๔ … ในกรณีท่ีไม่มีผูด้  ารงต าแหน่งรองปลดักระทรวง หรือมีแต่ไม่อาจปฏิบติั
ราชการได ้ปลดักระทรวงจะแต่งตั้งขา้ราชการในกระทรวงซ่ึงด ารงต าแหน่งไม่ต ่ากวา่ผูอ้  านวยการกองหรือเทียบเท่า
เป็นผูรั้กษาราชการแทนก็ได ้
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 มาตรา ๔๕ ใหน้ าความในมาตรา ๔๔ มาใชบ้งัคบัแก่กรณีท่ีไม่มีผูด้  ารงต าแหน่งปลดัทบวงหรือรองปลดั
ทบวงตามมาตรา ๒๔ หรือมาตรา ๒๘ ดว้ยโดยอนุโลม 
23. กรมหน่ึงๆ ไม่มีผูด้  ารงต าแหน่งเลขานุการกรม  อธิบดีกรมแต่งตั้งขา้ราชการระดบัใดเป็นผูรั้กษาราชการแทน 
 ก. หวัหนา้กอง  ข. ผูต้รวจราชการ ค. ช านาญการพิเศษ ง. รองอธิบดี 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๔๗ ในกรณีท่ีไม่มีผูด้  ารงต าแหน่งเลขานุการกรมตามมาตรา ๓๓ วรรคหน่ึง หรือ 
หวัหนา้ส่วนราชการตามมาตรา ๓๓ วรรคสอง หรือมีแต่ไม่อาจปฏิบติัราชการได ้ใหอ้ธิบดีแต่งตั้งขา้ราชการในกรม
คนหน่ึง ซ่ึงด ารงต าแหน่งไม่ต ่ากวา่หวัหนา้กองหรือเทียบเท่า เป็นผูรั้กษาราชการแทน 
ใหน้ าความในมาตราน้ีมาใชบ้งัคบัแก่ส่วนราชการท่ีเรียกช่ืออยา่งอ่ืนและมีฐานะเป็นกรมดว้ยโดยอนุโลม 
24. การรักษาราชการแทน ตามพระราชบญัญติัน้ี มิใหใ้ชบ้งัคบัแก่ราชการในหน่วยงานได ้
 ก. ต ารวจ   ข. ทหาร  ค. ครู   ง. ตุลาการ 
ตอบ ข้อ ข.ค าอธิบาย    มาตรา ๕๐ ความในหมวดน้ีมิใหใ้ชบ้งัคบัแก่ราชการในกระทรวงท่ีเก่ียวกบัทหาร 
25. การส่ัง และการปฏิบติัราชการของกระทรวง ทบวง กรม ต่อบุคคลในคณะผูแ้ทน ใหเ้ป็นไปตามระเบียบท่ี
ใครก าหนด 
 ก. ปลดักระทรวงกลาโหม    ข. ผบ.ทร. 
 ค. ครม.      ง. รัฐมนตรีวา่การกระทรวงต่างประเทศ 
ตอบ ข้อ ค.ค าอธิบาย มาตรา ๕๐/๒ ใหห้วัหนา้คณะผูแ้ทนเป็นผูรั้บนโยบายและค าส่ังจากนายกรัฐมนตรีในฐานะ
หวัหนา้รัฐบาล คณะรัฐมนตรี กระทรวง ทบวง กรม มาปฏิบติัการใหเ้หมาะสมกบัการปฏิบติัราชการในต่างประเทศ 
และเป็นหวัหนา้บงัคบับญัชาบุคคลในคณะผูแ้ทน และจะใหมี้รองหวัหนา้คณะผูแ้ทนเป็นผูช่้วยส่ังและปฏิบติั
ราชการแทนหวัหนา้คณะผูแ้ทนก็ได ้
 การส่ัง และการปฏิบติัราชการของกระทรวง ทบวง กรม ต่อบุคคลในคณะผูแ้ทน ใหเ้ป็นไปตามระเบียบท่ี
คณะรัฐมนตรีก าหนดหวัหนา้คณะผูแ้ทนอาจมอบอ านาจใหบุ้คคลในคณะผูแ้ทนปฏิบติัราชการแทนตามระเบียบท่ี
คณะรัฐมนตรีก าหนด 
26. “ในกรณีท่ีไม่มีผูด้  ารงต าแหน่งหวัหนา้คณะผูแ้ทน หรือมีแต่ไม่อาจปฏิบติัราชการได ้ใหร้องหวัหนา้คณะ
ผูแ้ทนรักษาราชการแทน”ความในวรรคหน่ึงไม่ใหใ้ชบ้งัคบัแก่ผูใ้ดท่ีประจ าในต่างประเทศ 
 ก. ขา้ราชการฝ่ายทหาร ข. ขา้ราชการครู  ค. ขา้ราชการต ารวจ ง. ขา้ราชการกงสุล 
ตอบ ข้อ ก. ค าอธิบาย มาตรา ๕๐/๓ ในกรณีท่ีไม่มีผูด้  ารงต าแหน่งหวัหนา้คณะผูแ้ทน หรือมีแต่ไม่อาจปฏิบติั
ราชการได ้ใหร้องหวัหนา้คณะผูแ้ทนรักษาราชการแทน 
 ในกรณีท่ีไม่มีรองหวัหนา้คณะผูแ้ทนท่ีจะรักษาราชการแทนตามวรรคหน่ึง หรือไม่มีผูด้  ารงต าแหน่งใดอนั
เป็นบุคคลในคณะผูแ้ทน หรือมีแต่บุคคลดงักล่าวไม่อาจปฏิบติัราชการได ้ใหก้ารรักษาราชการแทนหวัหนา้คณะ
ผูแ้ทนหรือผูด้  ารงต าแหน่งใดอนัเป็นบุคคลในคณะผูแ้ทน เป็นไปตามระเบียบท่ีคณะรัฐมนตรีก าหนดความในวรรค
หน่ึงไม่ใชบ้งัคบักบัขา้ราชการฝ่ายทหารประจ าการในต่างประเทศ 
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 แนวข้อสอบพ.ร.บ.ระเบียบข้าราชการพลเรือน พ.ศ. 2551   
และที่แก้ไขเพิม่เติมฉบับท่ี 3. พ.ศ. 2562 

1. พระราชบญัญติัขา้ราชการพลเรือน  พ.ศ. 2551  ใชบ้งัคบัเม่ือใด 
 1.  ตั้งแต่วนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 2.  เม่ือพน้เกา้สิบวนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 3.  เม่ือพน้ร้อยยีสิ่บวนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
 4.  เม่ือพน้ร้อยแปดสิบวนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
ตอบ  1.  แนวคิด  มาตรา  1  พระราชบญัญติัน้ีเรียกวา่ “พระราชบญัญติัระเบียบขา้ราชการพลเรือน พ.ศ. 2551” 
มาตรา  2  พระราชบญัญติัน้ีใหใ้ชบ้งัคบั  ตั้งแต่วนัถดัจากวนัประกาศในราชกิจจานุเบกษาเป็นตน้ไป 
2. ในพระราชบญัญติัน้ี  “ขา้ราชการพลเรือน”  หมายความตามขอ้ใด 
 1.  บุคคลซ่ึงไดรั้บบรรจุใหรั้บราชการโดยไดรั้บเงินเดือนจากเงินในหน่วยงานท่ีสังกดั 
 2.  บุคคลซ่ึงไดรั้บบรรจุตามพระราชบญัญติัน้ีใหรั้บราชการโดยไดรั้บเงินเดือนจากเงินงบประมาณใน
กระทรวง  
 3.  บุคคลซ่ึงไดรั้บบรรจุและแต่งตั้งตามพระราชบญัญติัน้ีใหรั้บราชการโดยไดรั้บเงินเดือนจากเงิน
งบประมาณในกระทรวง  กรมฝ่ายพลเรือน 
 4.  บุคคลซ่ึงไดรั้บบรรจุและแต่งตั้งตามพระราชบญัญติัน้ีใหรั้บราชการโดยไดรั้บเงินเดือนจากเงิน
งบประมาณในหน่วยงานท่ีสังกดั 
ตอบ  3.  แนวคิด  มาตรา  4  ในพระราชบญัญติัน้ี 
 “ขา้ราชการพลเรือน”  หมายความวา่  บุคคลซ่ึงไดรั้บบรรจุและแต่งตั้งตามพระราชบญัญติัน้ี 
ใหรั้บราชการโดยไดรั้บเงินเดือนจากเงินงบประมาณในกระทรวง กรมฝ่ายพลเรือน 
3. ในพระราชบญัญติัน้ี  “ขา้ราชการฝ่ายพลเรือน”  หมายความตามขอ้ใด 
 1.  ขา้ราชการพลเรือน ในหน่วยงานนั้น  ตามกฎหมายวา่ดว้ยระเบียบขา้ราชการประเภทนั้น 
 2.  ขา้ราชการอ่ืนในกระทรวงกรมฝ่ายพลเรือน ตามกฎหมายวา่ดว้ยระเบียบขา้ราชการประเภทนั้น 
 3.  ขา้ราชการพลเรือน และขา้ราชการอ่ืนในกระทรวงกรมฝ่ายพลเรือน ตามกฎหมายวา่ดว้ยระเบียบ
ขา้ราชการประเภทนั้น 
 4.  ขา้ราชการพลเรือน และขา้ราชการอ่ืนในสังกดัหน่วยงานนั้นๆทุกฝ่าย 
ตอบ  3.  แนวคิด  มาตรา  4  ในพระราชบญัญติัน้ี 
 “ขา้ราชการฝ่ายพลเรือน” หมายความวา่  ขา้ราชการพลเรือน และขา้ราชการอ่ืน  ในกระทรวง 
กรมฝ่ายพลเรือน ตามกฎหมายวา่ดว้ยระเบียบขา้ราชการประเภทนั้น 
4. ผูใ้ดเป็นผูรั้กษาการตามพระราชบญัญติัน้ี 
 1.  นายกรัฐมนตรี     2.  รัฐมนตรีวา่การกระทรวงมหาดไทย 
 3.  ปลดักระทรวงมหาดไทย   4.  คณะกรรมการขา้ราชการพลเรือน 
ตอบ  1.  แนวคิด  มาตรา  5  ให ้นายกรัฐมนตรี รักษาการตามพระราชบญัญติัน้ี 
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5. ผูใ้ดเป็นประธาน ในคณะกรรมการขา้ราชการพลเรือน (ก.พ.) 
 1.  นายกรัฐมนตรี  หรือรองนายกรัฐมนตรีท่ีนายกรัฐมนตรีมอบหมาย 
 2.  รัฐมนตรีวา่การกระทรวงมหาดไทย 
 3.  ปลดักระทรวงมหาดไทย    4.  คณะกรรมการขา้ราชการพลเรือน 
ตอบ  1.  แนวคิด  มาตรา  6  ใหมี้คณะกรรมการขา้ราชการพลเรือนคณะหน่ึง เรียกโดยยอ่วา่ “ก.พ.” 
ประกอบดว้ยนายกรัฐมนตรีหรือรองนายกรัฐมนตรีท่ีนายกรัฐมนตรีมอบหมาย เป็นประธาน   
ปลดักระทรวงการคลงั ผูอ้  านวยการส านกังบประมาณ และเลขาธิการคณะกรรมการพฒันาการเศรษฐกิจ 
และสังคมแห่งชาติ เป็นกรรมการโดยต าแหน่ง และกรรมการซ่ึงทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้งจาก
ผูท้รงคุณวฒิุดา้นการบริหารทรัพยากรบุคคล ดา้นการบริหารและการจดัการ และดา้นกฎหมายซ่ึงมีผลงานเป็นท่ี
ประจกัษใ์นความสามารถมาแลว้ และเป็นผูท่ี้ไดรั้บการสรรหาตามหลกัเกณฑ ์วิธีการและเง่ือนไขท่ีก าหนดในกฎ 
ก.พ. จ านวนไม่นอ้ยกวา่หา้คน แต่ไม่เกินเจด็คน และใหเ้ลขาธิการ ก.พ.เป็นกรรมการและเลขานุการ 
6. กรรมการซ่ึงทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้ง  ใหอ้ยูใ่นต าแหน่งไดค้ราวละก่ีปี 
 1.  2  ปี   2.  3  ปี   3.  4  ปี   4.  5  ปี 
ตอบ  2.  แนวคิด  มาตรา  7   กรรมการซ่ึงทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้งใหอ้ยูใ่นต าแหน่งไดค้ราวละ สามปี ถา้
ต าแหน่งกรรมการวา่งลงก่อนก าหนดและยงัมีกรรมการดงักล่าวเหลืออยูอี่กไม่นอ้ยกวา่สามคนใหก้รรมการท่ีเหลือ
ปฏิบติัหนา้ท่ีต่อไปได ้
7. เม่ือต าแหน่งกรรมการใน ก.พ. วา่งลงก่อนก าหนด  ใหด้ าเนินการแต่งตั้งกรรมการแทนภายในก าหนดก่ีวนั 
 1.  30  วนั   2.  60  วนั  3.  120  วนั  4.  180  วนั 
ตอบ  1.  แนวคิด  มาตรา  7  วรรคสอง  เม่ือต าแหน่งกรรมการวา่งลงก่อนก าหนดใหด้ าเนินการแต่งตั้งกรรมการ
แทนภายในก าหนด  สามสิบวนั เวน้แต่วาระของกรรมการเหลือไม่ถึงหน่ึงร้อยแปดสิบวนัจะไม่แต่งตั้งกรรมการ
แทนก็ไดผู้ซ่ึ้งไดรั้บแต่งตั้งเป็นกรรมการแทนนั้นใหอ้ยูใ่นต าแหน่งไดเ้พียงเท่าก าหนดเวลาของผูซ่ึ้งตนแทน 
8. ในกรณีท่ี ก.พ. มีมติวา่กระทรวง กรม หรือผูมี้หนา้ท่ีปฏิบติัตามพระราชบญัญติัน้ี   ไม่ปฏิบติัตาม
พระราชบญัญติัน้ี  เม่ือ  ก.พ.  ได ้แจง้ใหก้ระทรวง กรม หรือผูมี้หนา้ท่ีปฏิบติัดงักล่าวด าเนินการแกไ้ขยกเลิก หรือ
ยติุการด าเนินการนั้นภายในเวลาท่ีก าหนดแลว้   แต่บุคคลดงักล่าวไม่ด าเนินการตามมติ ก.พ. ภายในเวลาท่ีก าหนด
โดยไม่มีเหตุอนัสมควร  ทั้งน้ี   จะมีผลตามกฎหมายอยา่งไร 
 1. ถือเป็นการไม่ปฏิบติัตามค าส่ัง   2. ถือเป็นการผิดวินยั 
 3. ถูกทั้งขอ้ 1.  และ  2.    4. ไม่มีขอ้ใดถูก 
ตอบ  2.  แนวคิด  มาตรา  9  ในกรณีท่ี ก.พ. มีมติวา่กระทรวง กรม หรือผูมี้หนา้ท่ีปฏิบติัตามพระราชบญัญติัน้ีไม่
ปฏิบติัตามพระราชบญัญติัน้ี หรือปฏิบติัการโดยขดัหรือแยง้กบัแนวทางตามท่ีก าหนดในพระราชบญัญติัน้ี ให ้ก.พ. 
แจง้ใหก้ระทรวง กรม หรือผูมี้หนา้ท่ีปฏิบติัดงักล่าวด าเนินการแกไ้ขยกเลิก หรือยติุการด าเนินการดงักล่าวภายใน
เวลาท่ีก าหนดในกรณีท่ีกระทรวง กรม หรือผูมี้หนา้ท่ีปฏิบติัดงักล่าวไม่ด าเนินการตามมติ ก.พ. ภายในเวลาท่ี
ก าหนดโดยไม่มีเหตุอนัสมควรใหถื้อวา่ ปลดักระทรวง อธิบดี หรือผูมี้หนา้ท่ีปฏิบติัดงักล่าวแลว้แต่กรณี  กระท าผิด
วินยั 
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9. การด าเนินการทางวนิยัและการส่ังลงโทษตาม มาตรา 9 วรรคหน่ึงใหเ้ป็นอ านาจหนา้ท่ีของผูใ้ด 
 1.  นายกรัฐมนตรี  2.  ก.พ.   3.  อ.ก.พ.  4.  ปลดักระทรวงมหาดไทย 
ตอบ  2.  แนวคิด  มาตรา  9  วรรคสอง  การด าเนินการทางวินยัตามวรรคหน่ึง และการส่ังลงโทษใหเ้ป็นอ านาจ
หนา้ท่ีของ  ก.พ. ตามหลกัเกณฑ ์วิธีการ และเง่ือนไขท่ีก าหนดในกฎ ก.พ. 
10. ในกรณีท่ี  ก.พ.  เห็นวา่การบริหารทรัพยากรบุคคลในเร่ืองใดท่ีขา้ราชการฝ่ายพลเรือนทุกประเภทหรือบาง
ประเภท  ควรมีมาตรฐานหรือหลกัเกณฑเ์ดียวกนั ให ้ก.พ. กระท าการตามขอ้ใด 
 1.  ออกกฎระเบียบขอ้บงัคบัไดท้นัที 
 2.  ออกหนงัสือช้ีแจงระหวา่งผูแ้ทน ก.พ. ผูแ้ทน ก.พ.ร. และผูแ้ทนองคก์รกลางบริหารงานบคุคลของ
ขา้ราชการฝ่ายพลเรือนประเภทต่าง ๆ ท่ีเก่ียวขอ้ง 
 3.  จดัใหมี้การประชุมเพ่ือหารือร่วมกนัระหวา่งผูแ้ทน ก.พ. ผูแ้ทน ก.พ.ร. และผูแ้ทนองคก์รกลางบริหารงาน
บุคคลของขา้ราชการฝ่ายพลเรือนประเภทต่าง ๆ ท่ีเก่ียวขอ้ง 
 4.  ถูกทุกขอ้ 
ตอบ  3.  แนวคิด  มาตรา  10  ในกรณีท่ี ก.พ. เห็นวา่การบริหารทรัพยากรบุคคลในเร่ืองใดท่ีขา้ราชการฝ่ายพลเรือน
ทุกประเภทหรือบางประเภทควรมีมาตรฐานหรือหลกัเกณฑเ์ดียวกนั ให ้ก.พ. จดัใหมี้การประชุมเพ่ือหารือร่วมกนั
ระหวา่งผูแ้ทน ก.พ. ผูแ้ทน ก.พ.ร. และผูแ้ทนองคก์รกลางบริหารงานบคุคลของขา้ราชการฝ่ายพลเรือนประเภท 
ต่าง ๆ ท่ีเก่ียวขอ้ง   เพ่ือก าหนดมาตรฐานหรือหลกัเกณฑก์ลางการบริหารทรัพยากรบุคคลในเร่ืองนั้นเสนอต่อ 
คณะรัฐมนตรี และเม่ือคณะรัฐมนตรีใหค้วามเห็นชอบแลว้ใหใ้ชบ้งัคบัมาตรฐานหรือหลกัเกณฑก์ลางดงักล่าวกบั
ขา้ราชการฝ่ายพลเรือนทุกประเภทหรือประเภทนั้น ๆแลว้แต่กรณี 
 ความในวรรคหน่ึงใหใ้ชบ้งัคบักบักรณีท่ีมีปัญหาเก่ียวกบัวิธีการบริหารทรัพยากรบุคคลของรัฐในเร่ืองใด
เร่ืองหน่ึงดว้ยโดยอนุโลม 
11. ก.พ. มีอ านาจแต่งตั้งคณะอนุกรรมการวิสามญัเรียกโดยยอ่วา่  “อ.ก.พ. วิสามญั” เพื่อท าการตามขอ้ใด 
 1.เพื่อท าการสอบสวนคดีวินยัโดยเฉพาะ 
 2.เพ่ือท าการพิจารณาปรับขั้นเงินเดือนหรือการเล่ือนต าแหน่งขา้ราชการโดยเฉพาะ 
 3.เพื่อท าการใดๆ แทนได ้    4.ถูกขอ้ 
ตอบ  3.  แนวคิด  มาตรา  12  ก.พ. มีอ านาจแต่งตั้งคณะอนุกรรมการวิสามญั เรียกโดยยอ่วา่ “อ.ก.พ. วิสามญั”  เพื่อ
ท าการใด ๆ แทนได ้
12. ใหมี้คณะอนุกรรมการสามญั  เรียกโดยยอ่วา่ “อ.ก.พ. สามญั” เพื่อวตัถุประสงคต์ามขอ้ใด 
 1.  เพ่ือท าการสอบสวนความผิดวินยัขั้นร้ายแรงโดยเฉพาะ 
 2.  เพ่ือเป็นองคก์รบริหารทรัพยากรบุคคลในส่วนราชการต่าง ๆ 
 3.  เพ่ือพิจารณาภารกิจต่างๆร่วมกบั ก.พ.  4.  ถูกทุกขอ้ 
ตอบ 2.  แนวคิด  มาตรา  14  ใหมี้คณะอนุกรรมการสามญั เรียกโดยยอ่วา่ “อ.ก.พ. สามญั” เพื่อเป็นองคก์รบริหาร
ทรัพยากรบุคคลในส่วนราชการต่าง ๆ  ดงัน้ี 
 (1)  คณะอนุกรรมการสามญัประจ ากระทรวง เรียกโดยยอ่วา่ “อ.ก.พ. กระทรวง” โดยออกนามกระทรวง 
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 (2)  คณะอนุกรรมการสามญัประจ ากรม เรียกโดยยอ่วา่ “อ.ก.พ. กรม” โดยออกนามกรม 
 (3)  คณะอนุกรรมการสามญัประจ าจงัหวดั เรียกโดยยอ่วา่ “อ.ก.พ. จงัหวดั” โดยออกนามจงัหวดั 
 (4)  คณะอนุกรรมการสามญัประจ าส่วนราชการอ่ืนนอกจากส่วนราชการตาม (1)  (2) และ (3) 
 การเรียกช่ือ องคป์ระกอบ และอ านาจหนา้ท่ีของ อ.ก.พ. ตาม (4) ใหเ้ป็นไปตามท่ีก าหนดในกฎ ก.พ. 
13. ผูใ้ดเป็นประธาน ใน “อ.ก.พ. กระทรวง”  
 1.  นายกรัฐมนตรี  2.  รัฐมนตรีเจา้สังกดั 3.  ปลดักระทรวง  4.  ผูแ้ทนจาก ก.พ. 
ตอบ  2.  แนวคิด  มาตรา  15  อ.ก.พ. กระทรวง ประกอบดว้ย รัฐมนตรีเจา้สังกดั เป็นประธาน ปลดักระทรวงเป็น
รองประธาน และผูแ้ทน ก.พ. ซ่ึงตั้งจากขา้ราชการพลเรือนในส านกังาน ก.พ. หน่ึงคนเป็นอนุกรรมการโดย
ต าแหน่ง และอนุกรรมการซ่ึงประธาน อ.ก.พ. แต่งตั้งจาก 
 (1)  ผูท้รงคุณวฒิุดา้นการบริหารทรัพยากรบุคคล ดา้นการบริหารและการจดัการ และดา้นกฎหมาย ซ่ึงมี
ผลงานเป็นท่ีประจกัษใ์นความสามารถมาแลว้ และมิไดเ้ป็นขา้ราชการในกระทรวงนั้นจ านวนไม่เกินสามคน 
 (2)  ขา้ราชการพลเรือนผูด้  ารงต าแหน่งประเภทบริหารระดบัสูงในกระทรวงนั้น ซ่ึงไดรั้บเลือกจากขา้ราชการ
พลเรือนผูด้  ารงต าแหน่งดงักล่าว จ านวนไม่เกินหา้คนให ้อ.ก.พ. น้ีตั้งเลขานุการหน่ึงคน 
14. ผูใ้ดเป็นประธาน ใน “อ.ก.พ. กรม” 
 1.  รัฐมนตรีกระทรวงฯ 2.  อธิบดีกรมฯ  3.  ปลดักระทรวง  4.  ผูแ้ทน จาก ก.พ. 
ตอบ  2.  แนวคิด  มาตรา  17  อ.ก.พ. กรม  ประกอบดว้ย  อธิบดี เป็นประธาน รองอธิบดีท่ีอธิบดีมอบหมายหน่ึงคน 
เป็นรองประธาน และอนุกรรมการซ่ึงประธาน อ.ก.พ. แต่งตั้งจาก 
 (1)  ผูท้รงคุณวฒิุดา้นการบริหารทรัพยากรบุคคล ดา้นการบริหารและการจดัการและดา้นกฎหมาย ซ่ึงมี
ผลงานเป็นท่ีประจกัษใ์นความสามารถมาแลว้ และมิไดเ้ป็นขา้ราชการในกรมนั้นจ านวนไม่เกินสามคน 
 (2)  ขา้ราชการพลเรือนซ่ึงด ารงต าแหน่งประเภทบริหารหรือประเภทอ านวยการในกรมนั้นซ่ึงไดรั้บเลือกจาก
ขา้ราชการพลเรือนผูด้  ารงต าแหน่งดงักล่าว จ านวนไม่เกินหกคน 
 ให ้อ.ก.พ. น้ีตั้งเลขานุการหน่ึงคน 
15. ผูใ้ดเป็นประธานใน “อ.ก.พ.จงัหวดั” 
 1.  ผูว้า่ราชการจงัหวดั 2.  ปลดัจงัหวดั  3.  นายก อ.บ.จ.  4.  ผูแ้ทน จาก ก.พ. 
ตอบ  1.  แนวคิด  มาตรา  19  อ.ก.พ. จงัหวดั ประกอบดว้ย  ผูว้า่ราชการจงัหวดั เป็นประธาน รองผูว้า่ราชการ
จงัหวดัท่ีผูว้า่ราชการจงัหวดัมอบหมายหน่ึงคน เป็นรองประธาน และอนุกรรมการ ซ่ึงประธาน อ.ก.พ.แต่งตั้งจาก 
 (1)  ผูท้รงคุณวฒิุดา้นการบริหารทรัพยากรบุคคล ดา้นการบริหารและการจดัการ และดา้นกฎหมาย ซ่ึงมี
ผลงานเป็นท่ีประจกัษใ์นความสามารถมาแลว้ และมิไดเ้ป็นขา้ราชการพลเรือนในจงัหวดันั้น จ านวนไม่เกินสามคน 
 (2)  ขา้ราชการพลเรือนซ่ึงด ารงต าแหน่งประเภทบริหารหรือประเภทอ านวยการ ซ่ึงกระทรวงหรือกรม
แต่งตั้งไปประจ าจงัหวดันั้น และไดรั้บเลือกจากขา้ราชการพลเรือนผูด้  ารงต าแหน่งดงักล่าวจ านวนไม่เกินหกคน ซ่ึง
แต่ละคนตอ้งไม่สังกดักระทรวงเดียวกนั 
 ให ้อ.ก.พ. น้ีตั้งเลขานุการหน่ึงคน 
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16. ใหมี้คณะกรรมการพิทกัษร์ะบบคุณธรรมคณะหน่ึง  เรียกโดยยอ่วา่อะไร 
 1.  “ค.พ.ค.”  2.  “ก.พ.ค.”  3.  “ก.พ.ธ.”  4.  “ก.ค.” 
ตอบ  2.  แนวคิด  มาตรา  24  วรรคหน่ึง  ใหมี้คณะกรรมการพิทกัษร์ะบบคุณธรรมคณะหน่ึง เรียกโดยยอ่วา่ 
“ก.พ.ค.”  ประกอบดว้ยกรรมการจ านวนเจด็คนซ่ึงทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้งตามมาตรา 26 
17. คณะกรรมการพิทกัษร์ะบบคุณธรรม  ประกอบดว้ยกรรมการทั้งหมดก่ีคน 
 1.  5  คน   2.  6  คน  3.  7  คน  4.  8  คน 
ตอบ  3.  แนวคิด  มาตรา  24  วรรคหน่ึง  ใหมี้คณะกรรมการพิทกัษร์ะบบคุณธรรมคณะหน่ึง เรียกโดยยอ่วา่ 
“ก.พ.ค.”  ประกอบดว้ย กรรมการจ านวน  เจด็คน  ซ่ึงทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้งตามมาตรา 26 
18. ผูใ้ดเป็นประธานคณะกรรมการคดัเลือกกรรมการ  ก.พ.ค. 
 1.  ประธานศาลฎีกา    2.  ประธานศาลปกครองสูงสุด 
 3.  นายกรัฐมนตรี     4.  รัฐมนตรีวา่การกระทรวงมหาดไทย 
ตอบ  2.  แนวคิด  มาตรา  26  วรรคหน่ึง  ใหมี้คณะกรรมการคดัเลือกกรรมการ ก.พ.ค. ประกอบดว้ย  ประธานศาล
ปกครองสูงสุด เป็นประธาน  รองประธานศาลฎีกาท่ีไดรั้บมอบหมายจากประธานศาลฎีกาหน่ึงคนกรรมการ ก.พ. 
ผูท้รงคุณวฒิุหน่ึงคนซ่ึงไดรั้บเลือกโดย ก.พ. และใหเ้ลขาธิการ ก.พ. เป็นกรรมการและเลขานุการ 
19. กรรมการ  ก.พ.ค.  มีวาระการด ารงต าแหน่งก่ีปี  นบัแต่วนัท่ีทรงพระกรุณาโปรดเกลา้ ฯ แต่งตั้ง และใหด้ ารง
ต าแหน่งไดก่ี้วาระ 
 1.5  ปี  1  วาระ  2. 5  ปี  2  วาระ  3. 6  ปี  1  วาระ  4. 6  ปี  2  วาระ 
ตอบ  3.  แนวคิด  มาตรา  29    กรรมการ ก.พ.ค. มีวาระการด ารงต าแหน่ง หกปี นบัแต่วนัท่ีทรงพระกรุณาโปรด
เกลา้ ฯ แต่งตั้ง และใหด้ ารงต าแหน่งไดเ้พียงวาระเดียว 
20. การจดัระเบียบขา้ราชการพลเรือนตอ้งเป็นไปเพ่ือผลสัมฤทธ์ิต่อภารกิจของรัฐตามขอ้ใด 
 1.  ความสะดวก  และประหยดั   2.  ความสะดวก  และความคุม้ค่า 
 3.  ความมีประสิทธิภาพ  และความคุม้ค่า  4. ความประหยดั  และคุม้ค่า 
ตอบ  3.  แนวคิด  มาตรา  34  การจดัระเบียบขา้ราชการพลเรือนตอ้งเป็นไปเพ่ือผลสัมฤทธ์ิต่อภารกิจของรัฐ ความมี
ประสิทธิภาพ และ ความคุม้ค่า โดยใหข้า้ราชการปฏิบติัราชการอยา่งมีคุณภาพ คุณธรรม และมีคุณภาพชีวิตท่ีดี 
21. ขา้ราชการพลเรือน มีก่ีประเภท 
 1.  2  ประเภท  2.  3  ประเภท  3.  4  ประเภท  4.  5  ประเภท 
ตอบ  1.  แนวคิด  มาตรา  35    ขา้ราชการพลเรือนมี   2  ประเภท คือ 
 1.  ขา้ราชการพลเรือนสามญั   ไดแ้ก่ ขา้ราชการพลเรือนซ่ึงรับราชการโดยไดรั้บบรรจุแต่งตั้ง 
ตามท่ีบญัญติัไวใ้นลกัษณะ 4 ขา้ราชการพลเรือนสามญั 
 2.  ขา้ราชการพลเรือนในพระองค ์ ไดแ้ก่   ขา้ราชการพลเรือนซ่ึงรับราชการโดยไดรั้บบรรจุแต่งตั้งใหด้ ารง
ต าแหน่งในพระองคพ์ระมหากษตัริยต์ามท่ีก าหนดในพระราชกฤษฎีกา 
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22. การจ่ายเงินเดือนและเงินประจ าต าแหน่งใหข้า้ราชการพลเรือนใหเ้ป็นไปตามระเบียบท่ี ก.พ. ก าหนด  โดย
ความเห็นชอบผูใ้ด 
 1. นายกรัฐมนตรี  2. กระทรวงมหาดไทย 3. กระทรวงการคลงั 4. คณะรัฐมนตรี 
ตอบ  3.  แนวคิด  มาตรา  37  การจ่ายเงินเดือนและเงินประจ าต าแหน่งใหข้า้ราชการพลเรือนใหเ้ป็นไปตามระเบียบ
ท่ี ก.พ. ก าหนด  โดยความเห็นชอบของ กระทรวงการคลงั 
23. ขา้ราชการพลเรือนอาจไดรั้บเงินเพ่ิมส าหรับต าแหน่งพิเศษตามขอ้ใด 
 1.  ต าแหน่งท่ีประจ าอยูใ่นต่างประเทศ  2.  ต าแหน่งในบางทอ้งท่ี 
 3.  ต าแหน่งในบางสายงาน    4.  ถูกทุกขอ้ 
ตอบ  4.  แนวคิด  มาตรา  38   ขา้ราชการพลเรือนอาจไดรั้บเงินเพ่ิมส าหรับต าแหน่งท่ีประจ าอยูใ่นต่างประเทศ   
ต าแหน่งในบางทอ้งท่ี   ต าแหน่งในบางสายงาน  หรือ  ต าแหน่งท่ีมีเหตุพิเศษ  ตามระเบียบท่ี ก.พ. ก าหนดโดยความ
เห็นชอบของกระทรวงการคลงั 
24. ขา้ราชการพลเรือนอาจไดรั้บเงินเพ่ิมส าหรับต าแหน่งพิเศษและจะตอ้งไดรั้บความเห็นชอบจากผูใ้ด 
 1. นายกรัฐมนตรี  2. กระทรวงมหาดไทย 3. กระทรวงการคลงั 4. คณะรัฐมนตรี 
ตอบ  3.  แนวคิด  มาตรา  38  ขา้ราชการพลเรือนอาจไดรั้บเงินเพ่ิมส าหรับต าแหน่งท่ีประจ า 
อยูใ่นต่างประเทศต าแหน่งในบางทอ้งท่ี ต าแหน่งในบางสายงาน หรือต าแหน่งท่ีมีเหตุพิเศษตามระเบียบท่ี ก.พ. 
ก าหนดโดยความเห็นชอบของ  กระทรวงการคลงั 
25. วนัเวลาท างาน  วนัหยดุราชการตามประเพณี  วนัหยดุราชการประจ าปี และการลาหยดุราชการของ
ขา้ราชการพลเรือน  ใหเ้ป็นไปโดยก าหนดตามขอ้ใด 
 1. คณะรัฐมนตรีก าหนด 2. มติของ ก.พ.  3. นายกรัฐมนตรีมีค าส่ัง 4. ถูกทุกขอ้ 
ตอบ  1.  แนวคิด  มาตรา  39  วนัเวลาท างาน วนัหยดุราชการตามประเพณี วนัหยดุราชการประจ าปี และการลาหยดุ
ราชการของขา้ราชการพลเรือน ใหเ้ป็นไปตามท่ี  คณะรัฐมนตรีก าหนด 
26. การรับบุคคลเพ่ือบรรจุเขา้รับราชการและแต่งตั้งใหด้ ารงต าแหน่งตอ้งค านึงถึงขอ้ใด 
 1.  ความรู้ความสามารถของบุคคล   2.  ประโยชน์ของทางราชการ 
 3.  ความเป็นธรรม     4.  ถูกทุกขอ้ 
ตอบ  4.  แนวคิด  มาตรา  42 (1)  การจดัระเบียบขา้ราชการพลเรือนสามญัตามพระราชบญัญติัน้ีใหค้  านึงถึงระบบ
คุณธรรมดงัต่อไปน้ี 
 (1)  การรับบุคคลเพ่ือบรรจุเขา้รับราชการและแต่งตั้งใหด้ า รงต าแหน่ง ตอ้งค านึงถึงความรู้ความสามารถของ
บุคคล   ความเสมอภาค   ความเป็นธรรม   และประโยชน์ของทางราชการ 
27. การพิจารณาความดีความชอบ  การเล่ือนต าแหน่ง   และการใหป้ระโยชน์อ่ืนแก่ขา้ราชการ 
ตอ้งเป็นไปอยา่งเป็นธรรมโดยพิจารณาจากส่ิงใดเป็นอนัดบัแรก 
 1.ศกัยภาพ  2. ผลงาน 3. ความประพฤติ 4. ความมีมนุษยสัมพนัธ์ 
ตอบ  2.  แนวคิด   มาตรา  42 (3)  การจดัระเบียบขา้ราชการพลเรือนสามญัตามพระราชบญัญติัน้ีใหค้  านึงถึงระบบ
คุณธรรมดงัต่อไปน้ี 
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(3) การพิจารณาความดีความชอบ การเล่ือนต าแหน่ง และการใหป้ระโยชนอ่ื์นแก่ขา้ราชการตอ้ง
เป็นไปอยา่งเป็นธรรมโดยพิจารณาจาก  ผลงาน  ศกัยภาพ  และความประพฤติ  และจะน าความคิดเห็นทางการเมือง
หรือสังกดัพรรคการเมืองมาประกอบการพิจารณามิได ้
28. การด าเนินการทางวนิยัตอ้งเป็นไปตามวตัถุประสงคต์ามขอ้ใด

1. ยติุธรรม 2. ปราศจากอคติ
3. ค านึงถึงประโยชน์ของทางราชการเป็นส าคญั 4.  ถูกเฉพาะขอ้ 1.  และ  2.

ตอบ  4.  แนวคิด  มาตรา  42 (4)  การจดัระเบียบขา้ราชการพลเรือนสามญัตามพระราชบญัญติัน้ี  ใหค้  านึงถึงระบบ
คุณธรรมดงัต่อไปน้ี 

(4) การด าเนินการทางวินยั ตอ้งเป็นไปดว้ย  ความยติุธรรม และ โดยปราศจากอคติ
29. ต าแหน่งขา้ราชการพลเรือนสามญัมี   ก่ีประเภท

1. 2  ประเภท 2. 3  ประเภท 3. 4  ประเภท 4. 5  ประเภท
ตอบ  3.  แนวคิด  มาตรา  45   ต าแหน่งขา้ราชการพลเรือนสามญั   มี  4  ประเภท  ไดแ้ก่ 

1) ต าแหน่งประเภทบริหาร 2)ต าแหน่งประเภทอ านวยการ 3)ต าแหน่งประเภทวิชาการ  4)ต าแหน่งประเภท
ทัว่ไป 
30. ต าแหน่งประเภทบริหาร  ของขา้ราชการพลเรือน ไดแ้ก่ขอ้ใด 

1. ต าแหน่งหวัหนา้ส่วนราชการระดบักระทรวง 2.  ต าแหน่งหวัหนา้ส่วนราชการระดบักรม
3. รองหวัหนา้ส่วนราชการระดบักระทรวง 4. ถูกทุกขอ้

ตอบ  4.  แนวคิด  มาตรา  45 (1)   ต าแหน่งขา้ราชการพลเรือนสามญัมี  4 ประเภท ดงัต่อไปน้ี 
(1) ต าแหน่งประเภทบริหาร ไดแ้ก่   ต าแหน่งหวัหนา้ส่วนราชการ  และ  รองหวัหนา้ส่วนราชการระดบั

กระทรวง  กรม  และต าแหน่งอ่ืนท่ี ก.พ. ก าหนด  เป็นต าแหน่งประเภทบริหาร 
31. ต าแหน่งประเภทอ านวยการของขา้ราชการพลเรือน ไดแ้ก่ขอ้ใด

1. ต าแหน่งหวัหนา้ส่วนราชการท่ีต ่ากวา่ระดบักรม 2.  ต าแหน่งอ่ืนท่ี ก.พ. ก าหนด
3. ต าแหน่งท่ีจ าเป็นตอ้งใชผู้ส้ าเร็จการศึกษาระดบัปริญญาตามท่ี ก.พ. ก าหนดเพ่ือปฏิบติังานในหนา้ท่ีของ

ต าแหน่งนั้น 
4. ถูกทั้งขอ้ 1.  และ 2.

ตอบ  4.  แนวคิด  มาตรา  45(2)  ต าแหน่งขา้ราชการพลเรือนสามญัมี  4 ประเภท ดงัต่อไปน้ี 
(2) ต าแหน่งประเภทอ านวยการ  ไดแ้ก่  ต าแหน่งหวัหนา้ส่วนราชการท่ีต ่ากวา่ระดบักรมและต าแหน่งอ่ืนท่ี

ก.พ. ก าหนด  เป็นต าแหน่งประเภทอ านวยการ 
32. ต าแหน่งประเภทบริหารของขา้ราชการพลเรือนสามญั  มีก่ีระดบั

1. 2  ระดบั 2. 3  ระดบั 3. 4  ระดบั 4. 5  ระดบั
ตอบ  1.  แนวคิด  มาตรา 46 (1)  ระดบัต าแหน่งขา้ราชการพลเรือนสามญั มีดงัต่อไปน้ี 

(1) ต าแหน่งประเภทบริหาร   มีระดบัดงัต่อไปน้ี
(ก)  ระดบัตน้   (ข)  ระดบัสูง
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33. ต าแหน่งประเภทอ านวยการ  ของขา้ราชการพลเรือนสามญั มีก่ีระดบั 
 1.  2  ระดบั  2.  3  ระดบั  3.  4  ระดบั  4.  5  ระดบั 
ตอบ  1.  แนวคิด  มาตรา 46 (2)  ระดบัต าแหน่งขา้ราชการพลเรือนสามญั  มีดงัต่อไปน้ี 
 (2)   ต าแหน่งประเภทอ านวยการ  มีระดบัดงัต่อไปน้ี 
 (ก)  ระดบัตน้    (ข)  ระดบัสูง 
34. ต าแหน่งประเภทวิชาการของขา้ราชการพลเรือนสามญั  มีก่ีระดบั 
 1.  2  ระดบั  2.  3  ระดบั  3.  4  ระดบั  4.  5  ระดบั 
ตอบ  4.  แนวคิด  มาตรา 46 (3)  ระดบัต าแหน่งขา้ราชการพลเรือนสามญั  มีดงัต่อไปน้ี 
 (3)  ต าแหน่งประเภทวิชาการ  มีระดบัดงัต่อไปน้ี 
 (ก)  ระดบัปฏิบติัการ (ข)  ระดบัช านาญการ (ค)  ระดบัช านาญการพิเศษ  (ง)  ระดบัเช่ียวชาญ 
 (จ)  ระดบัทรงคุณวฒิุ 
35. ต าแหน่งประเภททัว่ไปของขา้ราชการพลเรือนสามญั มีก่ีระดบั 
 1.  2  ระดบั  2.  3  ระดบั  3.  4  ระดบั  4.  5  ระดบั 
ตอบ  3.  แนวคิด  มาตรา  46 (4)  ระดบัต าแหน่งขา้ราชการพลเรือนสามญั มีดงัต่อไปน้ี 
 (4)  ต าแหน่งประเภททัว่ไป   มีระดบัดงัต่อไปน้ี 
 (ก)  ระดบัปฏิบติังาน  (ข)  ระดบัช านาญงาน  (ค)  ระดบัอาวโุส  (ง)  ระดบัทกัษะพิเศษ 
36. ต าแหน่งขา้ราชการพลเรือนสามญัจะมีในส่วนราชการใด จ านวนเท่าใด และเป็นต าแหน่งประเภทใด สาย 
งานใด ระดบัใด  ใหเ้ป็นไปตามท่ีผูใ้ดก าหนด 
 1.  อ.ก.พ. กระทรวง 2.  ก.พ.   3.  คณะรัฐมนตรี  4.  นายกรัฐมนตรี 
ตอบ  1.  แนวคิด  มาตรา  47  ต าแหน่งขา้ราชการพลเรือนสามญัจะมีในส่วนราชการใด จ านวนเท่าใด และเป็น
ต าแหน่งประเภทใด สายงานใด ระดบัใด ใหเ้ป็นไปตามท่ี อ.ก.พ. กระทรวงก าหนด 
37. ผูใ้ดเป็นผูมี้หนา้ท่ีในการจดัท ามาตรฐานก าหนดต าแหน่ง   โดยจ าแนกต าแหน่งเป็นประเภทและสายงานตาม 
ลกัษณะงาน และจดัต าแหน่งในประเภทเดียวกนัและสายงานเดียวกนัท่ีคุณภาพของงานเท่ากนัโดยประมาณเป็น 
ระดบัเดียวกนั ทั้งน้ี โดยค านึงถึงลกัษณะหนา้ท่ีความรับผิดชอบและคุณภาพของงาน 
 1.อ.ก.พ.   2. ก.พ.   3. คณะรัฐมนตรี  4.อธิบดี กรมฯ 
ตอบ  2.  แนวคิด มาตรา  48  วรรคแรก  ให ้ ก.พ.  จดัท ามาตรฐานก าหนดต าแหน่ง  โดยจ าแนกต าแหน่งเป็น
ประเภทและสายงานตามลกัษณะงาน  และจดัต าแหน่งในประเภทเดียวกนัและสายงานเดียวกนัท่ีคุณภาพของงาน
เท่ากนัโดยประมาณเป็นระดบัเดียวกนั  ทั้งน้ี  โดยค านึงถึงลกัษณะหนา้ท่ีความรับผิดชอบและคุณภาพของงาน 
38. ผูใ้ดมีอ านาจพิจารณาปรับเงินเดือนขั้นต ่าขั้นสูงหรือเงินประจ าต าแหน่งของขา้ราชการพลเรือนสามญัให้
เหมาะสมยิง่ข้ึนตามความจ าเป็นได ้
 1.  ก.พ.   2.  อ.ก.พ.กระทรวง 3.  คณะรัฐมนตรี  4.  นายกรัฐมนตรี 
ตอบ  3.  แนวคิด  มาตรา  51  คณะรัฐมนตรี  จะพิจารณาปรับเงินเดือนขั้นต ่าขั้นสูงหรือเงินประจ าต าแหน่งของ
ขา้ราชการพลเรือนสามญัใหเ้หมาะสมยิง่ข้ึนตามความจ าเป็นก็ได ้
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